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TE Connectivity Corporation WINTOTAL Software License Agreement

Please read this License Agreement carefully before installing the software. By installing the software, you confirm your
agreement to all the terms and conditions listed in this License Agreement regarding your company's use of the TE
Connectivity Corporation Software Program entitled WINTOTAL.

This is a legal Agreement between you, the end user, and TE Connectivity Corporation (TE). BY INSTALLING THIS
SOFTWARE YOU ARE AGREEING TO BECOME BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE
TO THE TERMS OF THIS AGREEMENT, DO NOT DOWNLOAD THE SOFTWARE.

1. GRANT of LICENSE

WINTOTAL software is licensed, not sold, to you for use only under this license, and TE reserves any rights not
expressly granted to you. TE grants to you, the end user, the right to use this copy, including written materials if any,
of the WINTOTAL program at the location, company and address, to which TE issued this copy of the WINTOTAL
program. The WINTOTAL program is owned by TE and is protected by U.S. copyright laws and international treaty
provisions. You agree not to alter, merge, duplicate, decompile, or reverse engineer, copy for other locations, or
otherwise make this software available to any person or entity outside this location. All copies made by you are
subject to the terms and conditions of this Agreement.

2. OTHER RESTRICTIONS

a) You may not rent or lease the WINTOTAL program to anyone.

b) You agree to notify TE promptly if “bugs” or seemingly incorrect or anomalous results are discovered or
produced by the use of the WINTOTAL program.

¢) You agree that the WINTOTAL program, including written materials if any, may be modified or updated by TE at
any time, and you agree to use any updated version of the WINTOTAL program after you are notified of such
modifications or updates.

d) By installing the software, you acknowledge that you have read and understood the TE disclaimer of Warranty
and Limitation of Liability, set forth below.

e) You agree to use reasonable efforts to protect against the unauthorized copying and use of the WINTOTAL
program by others.

3. DISCLAIMER OF WARRANTY

THE WINTOTAL PROGRAM AND ACCOMPANYING WRITTEN MATERIALS ARE PROVIDED “AS IS" WITHOUT WARRANTY
OF ANY KIND. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE WINTOTAL PROGRAM IS ASSUMED
BY YOU. TE DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE WINTOTAL PROGRAM WILL MEET
YOUR REQUIREMENTS OR THAT THE OPERATION OF THE WINTOTAL PROGRAM WILL BE UNINTERRUPTED OR
ERROR FREE, OR THAT PROGRAM DEFECTS WILL BE CORRECTED.

4. LIMITED WARRANTY-MEDIA

THE MEDIUM ON WHICH THE SOFTWARE IS ENCODED IS WARRANTED TO BE FREE FROM DEFECTS IN MATERIAL
AND WORKMANSHIP UNDER NORMAL USE FOR A PERIOD OF SIXTY (60) DAYS FROM THE DATE OF DELIVERY TO
YOU AS EVIDENCED BY A COPY OF YOUR RECEIPT. THE ENTIRE LIABILITY OF TE AND YOUR EXCLUSIVE REMEDY IF THE
MEDIUM IS DEFECTIVE SHALL BE THE REPLACEMENT OF THE SOFTWARE.

5. EXCLUSION OF ALL OTHER WARRANTIES

EXCEPT AS EXPRESSLY PROVIDED ABOVE, TE DISCLAIMS ALL WARRANTIES, EITHER EXPRESS, IMPLIED, OR
STATUTORY, INCLUDING BUT NOT LIMITED TO ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR ANY
PURPOSE, EVEN IF TE HAS BEEN ADVISED OF SUCH PURPOSE. THIS AGREEMENT GIVES YOU THE SPECIFIC LEGAL
RIGHTS. SOME COUNTRIES DO NOT ALLOW THE EXCLUSION OF WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT
APPLY TO YOU.

6. LIMITATION OF LIABILITY

TE SHALL NOT BE LIABLE FOR ANY LOSS, DAMAGE, OR DELAY DURING SHIPMENT OR FOR ANY LOSS OF PROFITS,
LOSS OF USE, INTERRUPTION OF BUSINESS, NOR FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES OF ANYKIND WHATEVER UNDER THIS AGREEMENT OR OTHERWISE, WHETHER OR NOT TE HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.



7. TERMINATION
This License will automatically terminate without notice from TE if you fail to comply with any term or condition of this

Agreement. You agree, upon such termination, to return the WINTOTAL program or destroy it along with any backup
or other copies in your possession.

8. COMPLETE AGREEMENT

This Agreement constitutes the sole and complete understanding between the parties with respect to the WINTOTAL
program and its use and may not be varied except in writing signed by an authorized signatory of TE. You agree that
you may not rely on any representations concerning the WINTOTAL program to the extent they vary from this
Agreement, and such representations, if any, will neither add to nor vary the terms of this Agreement. To the extent
that any provisions of this Agreement conflict with government requirements to which your use of the WINTOTAL
program is subject, TE agrees that you may use the WINTOTAL program in accordance with such government
requirements.

9. CHOICE OF LAWS
This Agreement is governed by the laws of the State of New York.

10. ASSIGNMENT

You may not assign any right or obligation under this Agreement and any attempted assignment or delegation shall
be void.

11. INVALID PROVISIONS

If any of the provisions of this Agreement are invalid under any applicable statute or rule of law, they are to that extent
deemed omitted.



System Requirements

Computer: PC ( IBM compatible )

Processor: Processor Requirements are the same as for the Windows Operating System
Processor Requirements

Operating system: Microsoft Windows 7, 8, 8.1,10 and 11
Microsoft Windows Server 2008, 2012, 2016 and 2019
(32bit or 64bit)

Screen Resolution: 1024 x 768 pixels
Disk space required: 100MB of free disk space



This topic shows the main differences between this version and WinTotal vé6.

File Format
The following file format changes have been made.

New File Types
WinTotal v7 uses new file formats for saving all user created data. WinTotal v6 files can be converted
to these new types but they cannot be opened directly in this version.

For more information please read the following topics:

Data Management/Backup
Upgrading From Older Versions

Multi User Access
WinTotal v7 prevents files on a shared location being opened by two different users at the same time.
A message box will tell the user the computer name that has it opened. WinTotal v6 allowed multiple
users to open shared files but the last one would overwrite any changes made by others.

Set Description Removed
The Set Description option is no longer available.

Main Screen and Ribbon
The following changes have been made to the main screen and ribbon.

Opening Files
A standard Windows dialog is now used for opening files instead of the Selected Set list box.

Database Printing
This option has been moved to a sub item of the Import button.

MY Designs
New MY Designs option replaces the Design New Product and User Defined Layouts option.

For more information please read the following topics:

MY Designs
Add Product

Upgrading From Older Versions

Product Creation
The following changes have been made when creating and changing Products.

Add/Change Product Screen
This screen has been redesigned with the new option of creating a Favorites list of TE Layouts.

For more information please read the following topics:

Add Product

True Type Fonts

¢ All Windows True Type (TTF) fonts are now available as well as new options for Inverse, Italic and
Underline.

¢ New options for Default Font Style, Font Size and Use Only Default Font Style can be found in the
Options tab in the System Setup screen

For more information please read the following topics:




Add Product
Eont Selection

Overlap
The option for Overlap has been removed.

Auto Update Products
All products will automatically update with the latest template settings. In WinTotal v6 this was only
available as an option for User Defined Layouts.
This functionality is now applied to all Products.

Maximum Characters Allowed
In versions WinTotal v6.0.12 to WinTotal v6.1.16 some products allowed too many characters to be
entered into them.
This has now been fixed but some users may see missing data when converting from WinTotal v6 when
using BOM 060080, ETC 012060, ETC 025080, ETC 060080, HLX 125-2NEL60S, HLX 125-4NEL60S, HLC
031-WE125125T, HLC 03-WE125125T and HLC 10-WE125125T products.

Data Entry Changes
The following changes have been made for data entry.

Import Ascii Screen
This screen has been redesigned with the following options removed.

¢ View and Delete import file.
e Save option, options will be saved automatically

For more information please read the following topics:

Import Ascii Text

Import XMT Screen
This screen has been redesigned with the following options removed.

¢ View and Delete import file.
e Save option, options will be saved automatically
e Support for XMT files using the old CPI codes.

The following improvements have been made.

¢ Alignment options will no longer be applied to Auto Size Length Products as this caused an error.
e UTF8 BOM encoded files are now supported.

For more information please read the following topics:

Import XMT

Import Database Screen

This screen has been redesigned and has a new Database Connection wizard requiring the following
options to be removed.

Show Database fields.

Save option, options will be saved automatically

Format Numeric Field option, this is now handled in the Database Connection wizard.
Quantity Field option, this is now handled in the Database Connection wizard.

For more information please read the following topics:

Import Database
Database Connections



Database Printing Screen
This screen has been redesigned and has a new Database Connection wizard requiring the following
options to be removed.

Show Database fields.

Save option, options will be saved automatically

Format Numeric Field option, this is now handled in the Database Connection wizard.
Quantity Field option, this is now handled in the Database Connection wizard.

For more information please read the following topics:

Database Printing
Database Connections

Repeats
The Repeats option ( formerly Occurs ) will now default to the maximum repeats allowed not the
previous default of 1.

Serializations
e A new ribbon button to create Serializations now exists in the Data Entry Keypad Tab
e The Serialization Characters are no longer used to identify Serializations in a data file. This allows
files to be opened and printed by users using different Serialization Characters. Please note that if
the item is edited where the Serialization Characters are different they will be converted upon editing.

For more information please read the following topics:

Serializations Panel

MY Designs
¢ New MY Designs option now replaces the Design New Product and User Defined Layouts option.
e The option to make a MY Layout based upon a TE Layout has been removed.
¢ All MY Layout designs will only use a single Name field to identify them They can not be created using the
Family, Type, Size and Derivative options. Any converted from WinTotal v6 will be converted into a single
name and only visible in the MY Designs option in the Add Product screen.

For more information please read the following topics:

MY Designs
Add Product

Upgrading From Older Versions

Printing
The following changes have been made regarding printing.

Cable Markers
e The CM-NMX, CM-SCE-TP, HTCM-SCE-TP and NCM -SCE-TP Cable Markers types will now default to

the correct left margin for center aligned printers.
°

e The CM-NMX, CM-SCE-TP, HTCM-SCE-TP and NCM -SCE-TP Cable Markers types will print with a +1
dot offset in the vertical position compared to when printed on v6. WinTotal v6 calculated the
position incorrectly. This change will not be noticeable to the human eye as this is between 0.23 and
0.8mm depending on the printers resolution.

Label
The CP Labels will now select the Mark/Reflective sensor type at print time.

Advanced Print
This screen has been redesigned with new options for finding, sorting and printing products.



For more information please read the following topics:

Advanced Print

System Setup
The following changes have been made to the System Setup.

Directories Tab
The new Filter option in Advanced Print can have the folder specified for saving Filters.

Options Tab
The following changed have been made to the Options Tab.

Font Options
The default Font Style and Font Size can also now be configured as well as an option to prevent
user from changing the Font Style.

Cancel To Exit Import Screen
This option has been removed due to the two options below in the new import screen designs.

Import and Open
This option automatically opens the Output File after the import is completed.

Import
This will Import the Input File

View Tab
e The new field Type is now on as default in the Selected Product option.
e The CPI field has been removed as there are no CPI fonts support
e The Length field has been removed as this information is also in the Size field.

Terminology Changes
The following terminologies have been changed.

Set is now File
A Set used to refer to a .wdfu file and is no longer used.

File is now used to refer to the new file format .wdfx files.
Product is now split into multiple definitions

Template
A Template is one of the following

TE Layout
A TE Layout is a layout supplied by TE Connectivity covering the current items in the
Identification & Labeling ranges. These were previously called Standard Product.

MY Designs
A MY Design refers to any Template that has been created by the user and is not
supplied with the program.

There are two types of MY Design
MY Layout
A MY Layout refers to any empty dimensional layout that has been created by the

user. These were previously called Design New Product.

MY Product



A MY Product refers to a fully configured Product. These are based on either a TE
Layout or a MY Layout but have all the information required to be used as
Product. These were previously called User Defined Layouts.

For more information please read the following topics:

MY Designs
Upgrading From Older Versions

Product
A Product consists of a Template and all the items such as Lines, Font and other formatting
options.

Legend is now Item
A Legend used to refer to a single item created in the graphical interface. This is now called a Item

Marker is now Sub Item
A Marker used to refer to a division of a Legend. This would normally be a Quantity or Serialization
value. This is now called a Sub Item

Occurs is now Repeats
Occurs refer to how data is replicated on a Continuous Product and is now called Repeats



Introduction

WinTotal = TE

comnectivity

The WinTotal v7 software by TE Connectivity is a Cable Identification and Labeling program.

This powerful package makes printing TE Connectivity Identification products simple using pre-loaded templates.
It features a graphical user interface to simplify operator training and minimize errors.

Designed primarily for printing text it is also possible to print graphics and a variety of barcodes.

Supplied with pre-loaded TE Connectivity Identification templates with the option for users to create their own.
Using built in drivers controlling TE Connectivity recommended printers to ensure settings and parameters are
correct at the time of printing. It also allows the use of standard Windows drivers. Mark quality and permanence

cannot be guaranteed when non TE Connectivity tested printers and ribbons are used.

Data can be manually typed into the program or using one of its import functions data from ASCII text files and
databases can be imported. Eg. Microsoft Access and Excel.

Important Information

Please make regular backup copies of all data files.

For more information about the files used in the program see the Data Management/Backup topic.



Installing
The program is installed using an installer program.
The installer and program is available in the following languages.

Chinese

Deutsch (German)
English

Espaiiol (Spanish)
Francais (French)
Italian

Japanese

Korean

Nederlands (Dutch)
Norsk (Norwegian)
Portuguese (Brazil)
Russian

Turkish

Note

The installer is not UNICODE. Chinese, Japanese, Korean and Russian languages will only be visible if the
Windows Region and Language Settings for “"Language For Non Unicode Programs” option is configured
to that language.

The program is UNICODE, so any language can be selected regardless of the Windows configuration.
The program will default to the language selected in the installer, this can be changed later in the program via
the Options tab in the System Setup screen.

Please follow the instructions as per the installer program.

Activation
Each purchased copy of the program entitles the user to 1 License.

A License is issued in the form of a USB Hardware Key or Serial Number.

WINTOTAL-7-DONGLE
1-2186545-1
Supplied with a USB Hardware Key

WINTOTAL-7-END-USER-LICENCE
1-2186546-1

Supplied with a Serial Number which must be registered online.

For more information see the Software Licensing topic.



Each purchased copy of the program entitles the user to 1 License.
A License is issued in the form of a USB Hardware Key or Serial Number.

WINTOTAL-7-DONGLE
1-2186545-1
Supplied with a USB Hardware Key

WINTOTAL-7-END-USER-LICENCE

1-2186546-1
Supplied with a Serial Number which must be registered online.

On startup if a valid Serial Number Registration or USB Hardware Key Registration is not detected the program will
function fully for a 14 day Evaluation Period beginning from the first time WinTotal v7 is installed on a PC.

Once the Evaluation Period has expired then the program will run in Demo Mode.

The WinTotal - Evaluation Period screen will be displayed each time the program is started or a Print action is applied
within the Evaluation Period displaying the number of days remaining.

For more information see the Serial Number Registration or USB Hardware Key Registration topic depending on the
license purchased.



If the part number below was ordered then a unique Serial Number will be printed inside the cover of the packaging.
WINTOTAL-7-END-USER-LICENCE

1-2186546-1

Supplied with a Serial Number which must be registered online.

This Serial Number is the license so please store this in a safe place.

It contain 5 banks of 5 digits

A Serial Number for WinTotal v7 will be as below where the * characters will contain unique letters/numbers

W****_T****_A****_D****_s****

If the Serial Number does not contain the exact first letters for each bank as above then it is not for WinTotal v7 and
cannot be used.

If the program is not registered the WinTotal - Unregistered screen will be displayed where the program can be
registered via the Register Serial Number option.

If the program will not correctly register please contact Technical Support.

Important Information

e The program can be installed multiple times but should ONLY be registered once.

e The program licenses are not transferable between PC's. If this functionality is required then a hardware key version
version should be purchased. See the USB Hardware Key Registration topic for more information.

e The program allows for 2 different computers to be registered using 1 Serial Number. This is to cover; upgrades,
loss, damaged or replaced computers NOT multiple installations. ( this is in breach of the License Agreement )

e Once 2 different computers have been registered no further registration can take place ( unless authorized from TE
Connectivity Product Management )

e Only computers that require to Print need to be registered. Unregistered copies will run in Demo Mode. This has
full functionality but does not allow printing.




If the part number below was ordered then a USB Hardware Key will be attached to the inside of the packaging.
WINTOTAL-7-DONGLE

1-2186545-1

Supplied with a USB Hardware Key

This USB Hardware Key is the license.

The key must be coded for WinTotal v7 and will be labeled WinTotal v7.*** where *** will contain numbers used for
sub versions of WinTotal v7. The first number must be a 7.

Keys coded and labeled for older versions will not work.
If an old key is inserted the user will be prompted about this in the WinTotal - Unregistered screen.

For the key to function a please insert it and wait for the driver to be automatically installed by Microsoft Windows.
When completed the program can be launched.

If the key is removed the program will revert to Demo Mode.

If a WinTotal v7 key is not detected when the program is started please check:
1. The light on the key is on.

2. The USB port works on the PC - try using other devices.

3. There are no errors or conflicts in the Windows Device Manager.

If after checking the program is still in Demo Mode please contact Technical Support.

Important Information

e Only computers that require to Print need to be registered.

e Unregistered copies will run in Demo Mode. This has full functionality but does not allow printing.

e The keys used for older versions are physically identical but are internally coded differently.

e Never insert more than 1 of these keys at a time to the PC as the program will only check the first found key.

e Newer version keys will work on older versions. If it is required to have multiple versions only insert the highest
version key.



WinTotal - Unregistered

This screen is displayed when the program cannot detect a valid Serial Number Registration or USB Hardware Key
Registration

It will display information if an invalid USB Hardware Key is inserted or a warning if the Evaluation Period has
expired.

Options

Register Serial Number

This option allows the Register Serial Number screen to be displayed. Use this if a Serial Number version was
purchased.

WINTOTAL-7-END-USER-LICENCE
1-2186546-1
Supplied with a Serial Number which must be registered online.

Evaluate Program
This will display the WinTotal - Evaluation Period screen with a status of the Evaluation Period.
If this screen shows and a WinTotal v7 USB Hardware Key is inserted please see the USB Hardware Key
Registration topic.



This screen is used to enter the Software Registration details and should be used if the following program version
was purchased.

WINTOTAL-7-END-USER-LICENCE
1-2186546-1
Supplied with a Serial Number which must be registered online.

Complete the Customer Information section ensuring a valid email is used to receive confirmation with the Unlock
Code.

Please enter data correctly as it may be required for support or to retrieve a lost Serial Number.

Enter the Serial Number supplied with the software.

There are then 4 different ways to register, these options will only be available if the mandatory Customer
Information is entered correctly.

Options

Automatic Web Registration
This requires a Valid Internet Connection and connects to our registration server, retrieves the Unlock Code
and registers the program automatically.
Depending on the network security settings this option may not always be allowed to function.
If this method does not work use one of the other registration methods.

Manual Web Registration
This requires a Valid Internet Connection and transfers the entered data to one of the selected Web Sites to
give an Unlock Code.
This can then be entered into the Unlock Code box in the registration screen.
Some Internet Browsers can append a space to the end of the Unlock Code when copying to the Windows
Clipboard preventing the program accepting the Unlock Code.

Print Registration Data
This does not require a Valid Internet Connection and will print the registration details to any available
Windows Printer.
This printout can then be taken to any computer with internet access and used to manually enter the data.

Save Registration Data
This saves the registration details to a file, which can be transferred to a computer with a valid internet
connection.
When opened a web page displaying the Unlock Code will be shown.
This can then be entered into the Unlock Code box in the registration screen.

Note

If there is no available internet connection please contact the vendor where your purchased the program from or
Technical Support

Please provide them with one of the following:

e E-mail the file created using the Save Registration Data.

e Fax the printed registration data created using the Print Registration Data.



WinTotal - Evaluation Period

This screen is displayed when the program is not registered.
It will display the number of days remaining in the fully functional Evaluation Period.

If 0 days are shown then the program will run in Demo Mode.



If when started the program cannot detect a valid Serial Number Registration or USB Hardware Key Registration the
program will function fully for a 14 day Evaluation Period beginning from the first time WinTotal v7 is installed on a

PC.

The WinTotal - Evaluation Period screen will be displayed each time the program is started, or a Print action is applied
within the Evaluation Period displaying the number of days remaining.

For more information see the Serial Number Registration or USB Hardware Key Registration topic depending on the
license purchased.

Once the Evaluation Period has expired then the program will run in this mode.
A message telling the user this information will be displayed.

The following commands will then not function:
Database Printing

Print

Advanced Print

Manual Print

Paper Report

Print Log

XMT Import Server

All other functions will work on unregistered versions of the program allowing the user to create, edit, delete and
import data.



Printer Setup

The program uses its own built in drivers.
To select the correct driver select the Printer in the Printers tab in the System Setup screen.
Although the program uses its own drivers it must send data via the Microsoft Windows Print Spooler.

For the correct Port to be visible in the Printers tab in the System Setup screen and the Print screen a valid Printer
must be in the Windows Control Panel.

If the Port required is not available then please close the program and create a Printer to this Port in the Windows
Control Panel.

It is recommended that a "Generic / Text Only" driver is installed for each Port required to Print from using this
program.

Install the printer driver

Chaase your printer from the list, To instell the driver from an installation D, click Have Disk.

=
Manufacturer # || printers
Epson 0 | A
Evalis Card Priner 5] Generic [BM Graphics 9pin E
Fuji Xerox ) Generic [BM Graphics 9pin wide
Generic - || Eal s publiher Color Printer U
) This driver s digitally signed. Have Disk...

Tell me why driver signing is impertant

Please contact your IT Department/System Administrator for more information or help.



Starting The Program

The program can be launched from the WinTotal v7 shortcut. I I

This is created by the installer on the common Desktop folder and the all users Start Menu



WinTotal v7 cannot directly open files created in older versions.
The file types below show the different file types supported and their conversion options.

Data Files (Formerly Set Files)
The following are file types used in this and older versions.

.wdfx (WinTotal v7)
WinTotal v7 new file format uses files with the extension .wdfx
This is the only type of file that can be opened directly in this version.

.wdfu (WinTotal v6.0.00 to WinTotal v6.1.14)
They can not be directly opened but they can be converted using the Convert v6 Data option.

.wdf (WinTotal v5)
These files cannot be directly opened or converted in this version but can be converted to .wdfu files
using WinTotal v6.0.00 to WinTotal v6.1.16.

Custom Template Files

MY Product ( Formerly User Defined Layouts )
The following are file types used in this and older versions.

MY.tfs.wdfx (WinTotal v7)
WinTotal v7 new MY Designs option is used to store the My Product items in a file called
MY.TFS
This is the only type of file that can be opened directly in this version.

.wupx (WinTotal v6.1.00 to v6.1.14)
They can not be directly opened but they can be converted using the Convert v6 Data option.

.wupu (WinTotal v6.0.00 to v6.0.14)
These files cannot be directly opened or converted in this version but can be converted to .wupx
files using WinTotal v6.1.00 to WinTotal v6.1.16.

.wup (WinTotal v5)
These files cannot be directly opened or converted in this version but can be converted to .wupx
files using WinTotal v6.1.00 to WinTotal v6.1.16.

MY Layouts (Formerly Design New Products)
The following are file types used in this and older versions.

MY.tfs.wdfx (WinTotal v7)
WinTotal v7 new MY Designs option is used to store the MY Layout items in a file called MY.TFS
This is the only type of file that can be opened directly in this version.

custom.dat/custom.wtt (WinTotal v5 & WinTotal v6)
They can not be directly opened but they can be converted using the Convert v6 Data option.

Program Settings
If it is required to have the same settings as a previous installation the Convert v6 Data option can be used to

import ( compatible ) settings.

For more information please read the following topics:

New Features and Changes in v7
MY Designs - Import

Data Management/Backup




Basic Concepts

The following topics are available to give an overview of the program.

Quick Start

Screen Overview

M ration

Printer Support

Getting Data From External Sources
Sequential Numbers And Letters
Data Entry Order

System Administration



Press the New button to create a new file.

Press the Add Product button to configure the Product.

Press the Add Data button and type in the data to be printed.
Press the Print button to Print the data.

A=



Screen Overview

The main screen is divided into the following sections:

= O

Quick Access Controls Product Data Entry Print Style ~ Information -
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File Button

Ribbon

Quick Access Toolbar
Style Menu

Information Menu.

Section 2
Selected Product

Section 3
Data



This list box is used to select a Product to work with from the current data file.
Up to 100 Products can be created per file.

The list box is sorted as default by the order the Products are created.
This order can be temporarily changed by clicking on one of the column headings.

Default columns

e Template - the Template Name

e Type - TE Layout, MY Layout, MY Product or My Product - Formatted is shown to identify the Template
Type.

e Lines - the number of data Lines created. *

¢ Font - the Font used. *

e Printer - the Printer used.

e Color - the Color used

e Quantity - the quantity of Items. If an Auto Numbering Product is created then $$ will be displayed.

e Size - the Width and Height of the Product

Additional columns
The following additional columns can be used, configured via the View tab in the System Setup screen

¢ Double Sided - showing Yes or No depending on the Double Sided value.

¢ Bold - showing Yes or No depending on the Bold value. *

¢ Horizontal Align - the Horizontal Align value. *

e Vertical Align - the Vertical Align value. *

¢ Rotation - showing either 0, 90, 180 or 270 for the Rotation in ° for the Lines of data. *
¢ Height - the Height of the Product.

e Width - the Width of the Product

* These items will not be displayed for MY Designs that are the Type My Product - Formatted

For more information please read the following topics:

Add Product



This section contains the data for the Selected Product

Options

Item
This number is displayed on the left of the screen and is used to identify a Item number.

Quantity
This is where the quantity of a Item can be displayed.



Mouse Operation

The following mouse functions are available.

o Left click a Item to select or deselect it A selected Item is displayed with a red box around it. Multiple Items can
be selected.
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Printer Support

The program uses its own built in Printer drivers. supporting the following models.

Supported Templates ] Speed Prnt Back side Options
Printer Resolution Sleeve  Cable |Label Calirl;l:;:i:m ranee ':Z:S;y Order | Rotated | o
Marker Required mm/sec Reversed 180 -
Cab A4+300 ;ggsg QIO O @ | T e @ @ | s
Squix 6.3/300 ( ééégi | Q@ 0O O O |V e O Q| s
T200 Ident ;ggsg QO O 8 | NN e O @ | s
T200 Label ;Odo'zr;‘i Q0 O O 502'_1:5 100+10 € | € st
T2000CT ;égggi‘ LI 0 0 YUY e O @ | s
T208M ;so‘;r; QIO O © | P les| Q| @ | s
T212M ;5855; Q10 9 © 220 lows | )| @ | s
T2212 ;ﬁgﬁ[ﬂ QO O @ | e O @ | s
T312M ;gggg QO 0 © | % e @ © st
T312Mi ;3352? QO O © | % e @ O | s
T3212 ;ggsg QO O @ | e | @ | s
T3224 238'52; QI QO QO O 3?_'21_560 100 +10, ) | € | Last
T6112DS ;385;‘ O O @ | VP oo naA | NA | NA
TE3112 ;ggsg QO O @ | NN e @ @ | s
TE3124 égggg; QL O @ | NP e O @ | s
Zebra 170xi (é?)%%d) QIO O © %P e @ O st

For more information please read the following topics:

Multiple Application Port Printing (MAPP)

Printer Calibration




Multiple Application Port Printing (MAPP)

A specific Printer can be configured to Print specific Templates or files from a specific Data Directory.

The configuration options for this are infinite.

The example below if for a user with the following Printers and wishes to always Print the corresponding Templates

on that Printer.

No |Printer Port Templates to be printed
1 TE3124 USBO01 [SCE 1/4-2.00 Yellow Sleeves - not Double Sided plus all other non-defined Templates.
2 [T200 Ident |USB002 |SCE 1/8-2.00 White and Yellow Sleeves that are not Double Sided
3 [T6112DS |USB003 |All SCE Sleeve Templates that are Double Sided

This configuration in the Printers tab in the System Setup screen screen would look line as below.

Spstern Setup

Printers  Directories  Options

Default Printer Setup

Wi User Access  ®MT Import Server

Advanced Printer Setup

Default Printer Part

(TE3124 « | [useom v]
[C]Print Front Side As Back

|:| Cukker

:'

=-&h TE3124

£-&% T200 TIdent

=& TE112D5
=

Port U3EOOL

e - AhZgigned Temwplates
L SCE 1/4-2.00

YTellow
Port USEOOZ

e - AhZgigned Temwplates
- BCE 1/8-2.00
.............. SCE 1/8-2.00

YTellow
White
Port USEOO3

Azsighed Templates
SCE FEEA_wEEE

THEEHF

Double Sided (M)

Double Sided (M)
Double Sided (M)

Double Sided(¥)

Printer Parameters Enabls

Assign Prinker

+ S

%

Assign Templates

+| 5 (%]

Printer Parameters

+| %

Assign Direckory

+ 2 ¥

I K | | Cancel |

With this configuration the user would automatically get the correct data sent to the correct Printer

Note

For more information please contact your TE Connectivity representative.



Printer Calibration

This is required by some Printers before a Product can be successfully printed.
This process measures the Product and configures internal values according to this measurement.
The Printer must be correctly loaded with Ribbon and Product and be free from error messages.
This should always be done under the following conditions

1. Correct Print position cannot be achieved.

2. Product, Size, Color or material type is changed.

3. Printer has been used by other software programs.

See the Printer Support table to see which Printers require calibration using the Calibrate button in Print screen



Getting Data From External Sources

If the data to be printed exists in another source it can in most cases be accessed directly from the program.

Importing
This is when data is taken from an external file/data source and imported into the program. This data is then stored
for future use and printing.

Live Printing
This is similar to importing but no data is stored. The data is retrieved from the external file/data source, printed and
then deleted. This process ensures that the latest data from the source is always printed.

Three different data types that can be accessed, some of which are used in Importing and Live Printing methods.

Type In]_ported Live Printing

Ascii Text Files @Imoort Ascii Text e

XMT Files @Import XMT @XMT Import Server
Databases @mﬂggrt Database @Dgtggggg Printing




These files are usually generated by other programs but they can also be created manually using a text editor.
They normally have a .TXT or .CSV extension.

On Scored and multi column Products a Field Separator must be defined to specify the location of data.

A Field Separator(or delimiter) is a character used to specify how to split the data in a single line.

The ideal format is that 1 line of data equals to one Sleeve or row of Labels.

Example Output For All 4 Examples Below
Import Order: Down-Across OFF

AAAA BBBB ccCcCC
DDDD EEEE FFFF

GGGG HHHH 111}
JJJJ KKKK LLLL

Import Order: Down-Across ON

AAAA CCCC EEEE
BBBB DDDD FFFF

GGGG (11} KKKK
HHHH JJJJ LLLL

Example 1 - Delimited File in the preferred format.
AAAA, BBBB, CCCC, DDDD, EEEE, FFFF
GGGG, HHHH, IIII, JJJJ,KKKK, LLLL

Example 2 - Delimited File with the "Physical Lines Per Logical" option value set to 2.
AAAA, BBBB, CCCC
DDDD, EEEE, FFFF
GGGG, HHHH, IIII
JJJJ, KKKK, LLLL

Example 3 - Single Column File with the "One Field Per Line" option on.
AAAA
BBBB
CCcCC
DDDD
EEEE
FFFF
GGGG
HHHH
IITI
JJJad
KKKK
LLLL

Example 4 - Delimited File with “Ignore Line Breaks" option on.
This is useful for poorly formatted files.

AAAA, BBBB

CCCC, DDDD, EEEE
FFFF, GGGG

HHHH, IIII, JJJJ, KKKK
LLLL



These files contain a specific format unique to the program.

Product, Font, Color and quantities to Print are also specified in this file along with the data.

Up to 100 Products can be imported from one file.

The advantage of this format is that the user does not have to specify any parameters when importing as they are

defined in the file.

This file can be used with the XMT Import Server option to automatically detect, Import and Print XMT files.

The format and syntax of a XMT file is very specific and is described below.

The file name must have the extension . XMT.
The Name of the file will be used as the name for the data file it creates.
Eg. ABC123.XMT will Import as ABC123.wdfx

Line |CharacterData

1
2
3 1
2-21
22
23
Next
Available
Next
Available
4 1
5 1

Mandatory "TMS90"

Mandatory "9" character. Data after character is no longer required but can be present.
Mandatory "8" or "4".

TE Layouts and MY Layouts require "8"

MY Products require "4"

Template Name matching the name in the Selected Product screen.

Color code (allowed in Selected Product screen). See XMT Color Codes topic.

Font codes. See the XMT Font Codes topic.

Mandatory "S" or "D" to indicate if the Template is Single Sided S or Double Sided D.

Optional Length of Template (if Continuous).

The Length value used is mm to 2 decimal places.
Prefix with a I to use inch values up to 2 decimal places
Prefix with a M to use mm values up to 1 decimal place.

If no length value is specified then the Auto Size Length option will be applied.

Mandatory "7" character followed by a 4-digit quantity (0001-9999) for the quantity of the following

Item to create.
Mandatory "6" followed by the Data for a new line or Scored section.
If Double Sided (D) option is selected use "0" to specify the Back Side data

The lines 4 through 5 are then repeated for the data.

If a new Product is required then a new Line 3 type of data can be inserted

When the file is finished a "5" must be inserted as character 1 in the last line.



Example 1
Product
Font
Double Sided
Lines

File Contents

The imported file would look like below.

Yellow SCE 1/2-2.00 - (8SCE 1/2-2.00
10 Point Arial Bold - ("Arial::10(b)")
No - (S)

2

TMS90
9

8SCE 1/2-2.00

70001
6ITEM
6ITEM
70001
6ITEM
6ITEM
5

LINE
LINE

LINE
LINE

o
Template e unes [ ront
Fsevaam Tebat T

ITEM 1 LINE 1
ITEM 1 LINE 2

ITEM 2 LINE 1

4)

::10(b)"S



Example 2

Product 1 Product White 3/8-2.00 - (8SCE 3/8-2.00 9)
Font 10 Point Arial Bold - ("Arial::10(b)")
Double No - (S)
Sided
Lines 2

Product 2 Product Yellow 3/4-2.00 - (8SCE 1/2-2.00 4)
Font 7 Point Arial Bold - ("Arial::7(b)")
Double Yes - (D)
Sided
Lines 2

File Contents TMS90
9
8SCE 3/8-2.00 9"Arial::10(b)"S
70001

6ITEM 1 LINE 1
6ITEM 1 LINE 2
70001

6ITEM 2 LINE 1
6ITEM 2 LINE 2

8SCE 3/4-2.00 4"Arial::7 (b)"D
70001

6ITEM 1 FRONT LINE 1
6ITEM 1 FRONT LINE 2
OITEM 1 BACK LINE 1
OITEM 1 BACK LINE 2
70001

6ITEM 2 FRONT LINE 1
6ITEM 2 FRONT LINE 2
OITEM 2 BACK LINE 1
OITEM 2 BACK LINE 2
5

The imported file would look like below.

ITEM 2 LINE 1
ITEM 2 LINE 2

Tywe
T Lyout 7 Tt Al TEa




Example 3

Product 1

Product 2

File Contents

Product

Font

Double Sided
Lines

Length

Product

Font

Double Sided
Lines

Length

TMS90

9

8TTPA 010**-10
70001
6ITEM 1
70001
6ITEM 2
70001
6ITEM 3
70001
6ITEM 4
70001
6ITEM 5
8TTPA 010**-10
70001
6ITEM 1
70001
6ITEM 2
70001
6ITEM 3
70001
6ITEM4
70001
6ITEM 5
5

The imported file would look like below.

White TTPA 010**-10 - (TTPA 010**-10
10 Point Arial Bold - ("Arial::10(b)")

No - (S)
1

1 inch - (11.00)

Red TTPA 010**-10 - (TTPA 010**-10
10 Point Arial Bold - ("Arial::10(b)")

No - (S)
1
10mm - (10)

9"Arial:

2"Arial:

:10(b)"SI1.00

:10(b)"s10

2)

9)



XMT Color Codes

The Color codes for XMT Files below should be entered in position 22 of the Product record line of the XMT file.

0 = Black
1 = Brown
2 = Red

3 = Orange
4 = Yellow
5 = Green
6 = Blue

7 = Violet
8 = Grey
9 = White
A = Pink

B = Silver

| = Clear

J = Amber
K = Oyster

L =Tan



XMT Font Codes

This version of the program only supports True Type fonts.

The syntax below is required for True Type Fonts where the Font name must be identical to the name shown in the
Add Product screen.

"<Font name>::<Point Size>(<Bold and 6 and 9 Underline configuration>)"

The (<Bold and 6 and 9 underlined configuration>) enclosed in parenthesis is optional.
The letter "B" or "b" is used to specify Bold.

The string "U69" or "u69" is used to specify 6 and 9 underlined.

It is critical that the codes are created with the quotation and colons in exactly the correct position as in the samples
above.

Examples
Code Equating Font
8SCE 1/4-2.00 9"Arial::10(b)"D 10 point Arial, Bold
8SCE 1/4-2.00 9"Arial::10"S 10 point Arial, Single Sided
8SCE 1/4-2.00 9"Tahoma: :8 (bu69)"s 8 point Tahoma, Bold, 6 and 9 underlined
8SCE 1/4-2.00 9"Tahoma::14 (u69) "D 14 point Tahoma, 6 and 9 underlined
8SCE 1/4-2.00 9"Courier New::10 (b)"D10 point Courier New, Bold,

For more information please read the following topics:

Font Selection
Add Product



These are external files (Databases or Spreadsheets) that can be imported using Microsoft Windows ODBC (Open
Database Connectivity) technology.

Any ODBC compatible database can be used to import data into the program if the ODBC Database Driver is installed
and the user has the access rights to read the database.

Please contact your IT Department/System Administrator for more information or help.
There are two ways to access a Database, neither of them will make changes to the source database.

Import
This will Import the data and save it to a data file.

The database connection is used when importing.

Data changes in the database will not be automatically updated in the data file. To get updated database
data it the data in the program must be deleted and re-imported..

Once imported, the data is available to Print and edit as required.
This option is available from the Import Database screen.

Database Printing
This will Import and Print the data from the database but never save a data file.

The database connection is used when printing.
Data changes in the database will be automatically updated at print time.

The only option for this method is to Print.

Import and Database Printing options require a connection to the database, see the Database Connections option.

For more information please read the following topics:

Import
Database Printing

Troubleshooting
If connection to a ODBC Database give incorrect results please check the following

e The Database connecting to is not opened by another program.
e The correct ODBC drivers are installed.

Note

In Microsoft Excel there are two ways to specify which data is available in to the program.

1. All Data - The program will retrieve the data based on the data that can be found in the sheet.
2. Named Area - A data area defined in Microsoft Excel which are then available in the Database Connections option.



This screen shows all available Database Connections that can be used to print data.

The following commands are available:

Connection Name
This shows a list of any previously created connections. Select one of these will make the fields in the database
connection available to be printed.

New
This will begin the Database Connection Wizard starting with the Connection Name screen.
Edit
This will edit the currently selected connection by opening the Database Connection Wizard at the Select Source
screen.
Save As
This will open the Connection Name screen where a new name for the connection can be entered.
Information

This will open the Information screen showing technical information about the selected connection

Delete
This will delete the currently selected database connection.

Warning: The available connections can be used many times by different products. Only delete a connection
if you are sure that it is no longer needed.

Unselect
This option will unselect the connection, this removes the link to the connection but will not remove the
connection.



Information

This screen displays the technical information about the selected connection.

This information can be copied to clipboard for documentation purposes.



Database Connection Wizard

This wizard shows multiple screens to enable the correct connection of the database.

The following screens are available:

Connection Name
Select Source
Select Tables and Columns



Connection Name

This screen allows the user to enter a name for a connection.

This name must be unique.



This screen allows the type of source to be selected and configured.

The following types are available

Microsoft Excel Workbook
Microsoft Access Database
Microsoft SQL Server

MySQL Database
SQlLite 3 Database
ODBC Data Source

Selecting on one of the above will show the next items required to be configured

Note:

Some types may be not available for selection if the Microsoft Windows System does not have a valid ODBC driver
installed for this type.

Once this source type is selected the user can enter or browse for a compatible file type.

When configured click Next to go to the Select Table and Columns screen.

Support for Microsoft Excel Workbooks include the following file types

*xls

* xlsx

*xlsm

*xlsb

On most Microsoft Windows systems the driver for the file type .xls is installed by default

The xlsx, .xIsm and .xIsb drivers are installed automatically with Microsoft Office 2007 or later

If these drivers are not available they can be downloaded and installed separately with installing Microsoft Office

Please visits the Microsoft website and search for Access Database Engine.

Once downloaded and installed the newer versions of Microsoft Excel and Microsoft Access to be used.

Once this source type is selected the user can enter or browse for a compatible file type.
If the database is password protects the User Name and Password can be specified.

When configured click Next to go to the Select Table and Columns screen.

Support for Microsoft Access Databases include the following file types

*mdb
*accdb

On most Microsoft Windows systems the driver for the file type .mdb is installed by default
The .accdb driver is installed automatically with Microsoft Office 2007 or later
If these drivers are not available they can be downloaded and installed separately with installing Microsoft Office

Please visits the Microsoft website and search for Access Database Engine.



Once downloaded and installed the newer versions of Microsoft Access and Microsoft Excel to be used.

Once this source type is selected the following options can be configured.

"' Source
This is the Name or IP Address of the SQL Server.

"' Database
This is for the name of the Database in the SQL Server to connect to.

Windows Authentication
This will use the Windows Authentication settings for the current user to allow access to the database

User Name
If not using Windows Authentication then the user name for the SQL Server can be entered.

Password
If not using Windows Authentication then the password for the user name can be entered.

When configured click Next to go to the Select Table and Columns screen.

Support for Microsoft SQL Server Database from SLQ Server 2005 or later

Once this source type is selected the following options can be configured.

Source
This is the Name or IP Address of the MySQL Server.

‘' Database
This is for the name of the Database in the MySQL Server to connect to.

i User Name
This is for the user name for the MySQL Server.

Password
This is for the password for the MySQL Server.

When configured click Next to go to the Select Table and Columns screen.

Support for Microsoft SQL Server Database from MySQL 4.1 or later

Once this source type is selected the user can enter or browse for a compatible file type.

When configured click Next to go to the Select Table and Columns screen.

Once this type is selected the user can select one of the Database types configured in the ODBC Data Source
Administrator from the Microsoft Windows Control Panel.

If the ODBC type required is not visible then select the Launch ODDC Data Source Administrator button to open the
ODBC Data Source Administrator.

Here different ODBC DSN connection types can be added.
Select the required type and click Next to go to the Select Table and Columns screen.

Note:

There are two types of DSN that can be created



User DSN - this will only be available for the the current Windows User

System DNS - this will be available for all Windows Users - this is the recommended type to create/use.



This screen shows a list of all Tables within the selected database.
Select the required Table and then select the required columns.
By default all columns for a Table will be selected.

Selecting Finish will now allow the connection to be used.

Advanced Options
The following advanced options are available:

Format / Display Data
SQL Query Mode

This screen is divided into two sections

==
Format Data
This section has a table showing all selected columns. For each column the following information is available.

The column order can be changed by selecting a row item and using one of the 4 buttons to move the items up or
down the list.

Column
This shows the names of the selected columns.

"' Source Data
This shows the data as it is passed through the ODBC interface.

Formatted Data
This shows the data as it will be formatted for printing. This can be changed by clicking in the Data Format
column for the required Column name.

Data Format

This shows the formatting applied to the Column name. Clicking in this box will display a button which will
open the Current Format options where formatting can be configured.

"’ Alias Name (Used on Label)
This is a name that can be entered to make the fields in the database easily identified.

S Special Field Properties
Selecting this field will display the following field types. The following options are available:

Quantity Field
The quantity field is used to specify how many copies of a record is printed.

‘i Display Data
This section has a table showing data retrieved from the database

By default a small amount of records are read in. To view the entire database the Display All Records button will
load the remaining records. Please note this can take some time on large databases

To preview the data with the Formatted Data value check the View Formatted Data check box

The Current Format screen allows the selected columns output format to be specified.

The following columns are displayed:



‘' None
This option will remove any formatting and make the Source Data be the Formatted Data.

Number
This option is to be used to format Columns that are numbers. The following options are available:

“ir' Keep Number of Digits
This option will keep the number of digits used the same as in the Source Data.

‘' No of Digits
This option is enabled when the Keep Number of Digits is disabled. The number of digits can be then set
for the Formatted Data to contain.

For Example if the Source Data is 3795825 and the No of Digit is 4 then 5825 will be the Formatted data.

‘L' Remove All Decimals
This will remove all number information after the decimal point.

“ir' Remove Decimal Point
This option is enabled when the Remove All Decimals option is disabled. It will remove the decimal point in
the Formatted Data column.

' Decimal Places
This option can be used to set the number of decimal places to be used in the Formatted Data column.

"' Text
This option is used to format Columns that are text. The following options are available:

Text Conversion
This option allows the text to be converted using the following options:

‘' None
This will remove any text formatting.

' Capitalise All
This will make all the text in Uppercase.

"' Lowercase All
This will make all the text in Lowercase.

S Capitalise 1st
This will make the 1st letter of the entire field Uppercase.

S Capitalise 1st In Word
This will make the 1st letter in each word Uppercase

" Fixed Length
This option allows a fixed length for the selected column to be defined.

S Length
This determines the length to be used for the Fixed Length option.

"I Pad Character



This is the character to use to pad ( to fill ) any data that does not meet the Fixed Length with.

“i" Pad In Front
This makes the pad characters appear at the front of the data, unchecking it will add then to the end.

Selecting this option will remove the Table and Column selection and show a single SQL Query edit control.
By default the SQL query is made form the selection made in the Table and Column selection.
This can be edited with SQL syntax to do more advanced routines.

Please note that any changes made in the SQL Query Mode are not backward compatible with the normal Table
and Column selection mode.

They will be lost when reverting back to the Table and Column selection mode



Font Selection

When creating a Product a Windows Font must be defined.
A Windows Font is stored on the computer that is running the program.

Any Windows Font can be selected. Arial and Courier New are our recommended fonts as they are always available
on all Microsoft Windows Systems.

The decision on whether to use Arial or Courier New is dependent upon a number of issues.
Arial
Arial is a commonly used font in the Microsoft Windows environment. It is a clear font to read and offers good

readability.

The one disadvantage with Arial is that it is a Proportional Font. That is different letters can take up different
widths.

For example a W andalare dimensionally different.

This makes the feature to calculate the maximum characters per line not 100% accurate as it is character
dependent.

Arial Sample

THIS IS A SAMPLE OF THE ARIAL FONT
this is a sample of the arial font

Courier New
Courier New is a Proportional Serif Font. It is not as easy to read as Arial but still is a useful font.

A Serif font has "hats" and "tails" on all its characters.
It is not as tall when compared to the same point size in Arial.

The one advantage with Courier New is that it is a proportional font. That is letters are always the same width.
For example a W and a I are dimensionally the same.

Courier New Sample

THIS IS A SAMPLE OF THE COURIER NEW FONT
this is a sample of the courier new font



Sequential Numbers And Letters

Sequential Numbers And Letters are numbers or letters that can are incremented.

In this program they are called or Serializations and are handled in two methods depending on the Auto
Numbering Product option in the Add Product screen.

Auto Numbering Product Off
In this mode any created Serializations are fixed and will not change at Print time.
To change the Serializations they must be edited.
Individual Serializations can be created on for multiple Items.

Auto Numbering Product On
In this mode only one Item can be created but the Serializations can remember the last printed value.

When this Product is selected the next time it will continue with the Increment at the next value.

For more information please read the following topics:

Serializations Panel
Add Product



Data Entry Order

Templates can have data entered into them in different orders depending upon settings in the Options tab in the
System Setup screen.

There are two options that can effect this order

Edit Order: Down-Across
This option is only effective for the Data Entry Order.
For Import options then select the Import Order: Down-Across in the relevant Import screen.
The image below shows the order the fields will be edited in.

First Second First Third
Third Fourth Second Fourth

Disabled Enabled

Edit Order: Front-Back

This option is only effective for the Data Entry Order. and only affects Double Sided Products and works with
the Edit Order: Down-Across option.

Disabled
All the fields on the Front Side will be processed before the Back Side ones.

Enabled
The order will toggle from Front Side to Back Side for each individual field.



System Administration

The following topics are useful for System Administrators:

Data Management/Backup

User Access Control



All users must have full read/write access to the Settings Directory and its sub directories as well as the directories
where Data Files are to be saved.

Data Files
The program will automatically save any files created and edited in the program.

Data Files will have the file extension .wdfx which is the only file type that can be directly opened in this
version.

The user has the option to store these files in any Directory both locally and on a Network.

The default Data Directory be configured in Directories tab of the System Setup screen

The maximum length for a filename ( file and path ) is limited to 252 characters.

These files should be periodically backed up.

For more information please read the following topics:

Upgrading From Older Versions

Settings
The location of this Directory is different per installation but can be found in the About screen.
All of the programs configuration values are stored in the following files

¢ Settings Directory\Products\MY.tfs - This is the file used to store MY Designs

e Settings Directory\WinTotal.dbc - This is the file used to store program settings contained in the System
Setup screens.

¢ Settings Directory\softreg.ini - This is the file used to store registration details for Serial Number

Registration
e C:\ProgramData\WinTotal\DbSetup\*.dbset - These files store the Databases Connections

These files should be periodically backed up but only restored to the same PC or another PC if its
configuration is identical.



As default there are no user access limitations configured in the program, if required there are three levels of access
control.

These are configured in the User Access tab in the System Setup screen.
The access levels are defined by the following groups

Minimum Level
Users can only Open files and Print them.

Medium Level
Users can do all the Minimum Level options plus create New files, Add Data, Change Data or Import.
Users can not make or edit MY Designs or access the User Access tab in the System Setup screen.

Maximum Level
This allows full access.

In the User Access tab in the System Setup screen the option Customize Minimum And Medium Security Level can
allow the 2 lower access levels to be configured based on customer requirements.

Note

For the program to function correctly the users must have full read/write access to the Settings Directory and its sub
directories.

The directories where data is to be saved must also have full read/write access.

These rights are always required regardless of the User Access values in the program.



Program Reference

This section covers the functionality of commands in the program.
The main screen contains the following items:

File Button
Quick Access Controls Tab
Product Tab

Data Entry Tab
Print Tab

Style Menu

Information Menu

Quick Access Toolbar

For more information please read the following topics:

Screen Overview



File Button

This button I ! is located in the Top Left corner of the program and replaces the historic File menu.
The following items are available:

Ne

: E

Save As
Convert v6 Data

System Setup
Help

,_
o

’g
=

Exit

Note

These controls can be added to the Quick Access Toolbar for quick access.

For more information please read the following topics:

Screen Overview



This command will display a screen where the user will be required to enter the file name to be used. The user can
also change the Directory of where this file is located.

For more information about the files used in the program see the Data Management/Backup topic.



This command will display a screen where the user can browse for a data file to be loaded.

For more information about the files used in the program see the Data Management/Backup topic.



This command will display a screen where the user can save the current file name to a new name and/or new location.

For more information about the files used in the program see the Data Management/Backup topic.



This function allows Settings, Templates and Data Files to be imported from a working WinTotal v6 installed on the
same computer.

Options

Settings and Templates
This enables the Browse button which is used to for selection. This then allows the location of the currently
working WinTotal v6 program to be selected. This is where the WinTotalU.exe is located

Once selected the Convert button can be clicked allowing the following to be converted.

1. Design New Product items will be converted into a MY Layout

2. User Defined Layouts items will be converted into a MY Product

3. All compatible settings used in the WinTotal v6 version will be set in WinTotal v7. This will include all
printer settings and folder locations.

Note

It is recommended to use this option once based upon the working WinTotal v6 before converting data files
to ensure correct conversion

No changes to the WinTotal v6 settings are made, they are only read and imported into WinTotal v7

Data Files - Single Selection
This allows single or multiple WinTotal v6 data files to be selected for conversion to WinTotal v7 data files.

Note

The original WinTotal v6 files will not be changed but they will be renamed with a .bak extension.
This shows that they have been converted and prevents them being converted again by accident.
If a file already exists with the same name it will not be converted.

Data Files - Complete Directories

This will allow a completed Directory of WinTotal v6 data files to be converted to WinTotal v7 data files.
The Recursive option allows all items in sub directories to also be converted.

Note

The original WinTotal v6 files will not be changed but they will be renamed with a .bak extension.
This shows that they have been converted and prevents them being converted again by accident.
If a file already exists with the same name it will not be converted.

For more information please read the following topics:

Upgrading From Older Versions
New Features and Changes in v/



System Setup

This screen is used to configure settings for the program using the following tabs:

Printers

Directories
Options

View

User Access

XMT Impor rver



The Printers tab in the System Setup screen screen is used specify the Printers, Ports and their Parameters.

Options

Default Printer
This is where the Default Printer can be selected. See the Printer Support topic for more information.

Port
The port for the selected printer can be selected or typed in. See the Printer Support topic for more information.

Print Front Side As Back
This option inverts either the sequence or orientation of the items when printing Front and Back sides of a

Product.

This option is not available for the following printers:

T6112DS

Cutter
Enable this if a Cutter is attached to the printer. Some printers error if a cut command is received and no Cutter is
present.

Use Default Windows Printer
When enabled the Windows Printer will print to the default printer specified in the Windows Control Panel.

When disabled a prompt to select the printer will be shown at Print time.

This option is only available for the following printers:

Windows Printer

Copy Front Side Data To Back Side
This will automatically copy data entered on the Front Side of a Product to the Back Side.

This option is only available for the following printers:

T6112DS
Double Print Optimize
When enabled, using compatible firmware and a correctly configured printer, wastage between print jobs can be

eliminated.

This option is only available for the following printers:

T6112DS
Contact Technical Support for more information on how to configure this option.

Import
This can import a file created using the Export function to configure the printers. Importing a file will overwrite any
previous Printer configurations.
Please ensure a backup using the Export option was completed before importing a new one. Only valid Printers
will be imported with valid Product mapping.

Export
This option will allow a user to Export the current Printer configuration.
This can be used for backup or to configure another installation.



Advanced Printer Setup

The :I button will show and hide the Advanced Printer Setup section

System Setup

Pinters | Diectories Options View  UserAccess XMT Import Server
Defaul Printer Setup
Default Printer Port
TE24 | [useom -
] Fiint Front Side s Back Expart
[ Cutter

Impart

Advanced Printer Setup

-&h TE3124 Port USBODL

Assign Printer sign Templates Assign Directory

cancel

This allows the configuration of multiple Printers with assigned Templates or Directories.

For more information please read the following topics:

Multiple Application Port Printing (MAPP)

Options

Assign Printer
The options below are for configuring Printers in the Advanced Printer Setup section.

Add V"

Add a new Printer from the Add/Change Printer screen.

n
Change
Changes the selected Printer in the Add/Change Printer screen. Not allowed for the Default Printer

Delete %

Deletes the selected Printer. Not allowed for the Default Printer.

Assign Templates
The options below are for assigning Templates to the selected Printer.
If a Product using this Template is printed it will print on this Printer.

Add ¥V
Add a new Template in the Assign Template To Printer screen.

o)
Change &
Change the selected Template in the Assign Template To Printer screen.

Delete %

Change the selected Template in the Assign Template To Printer screen.

Printer Parameters
This screen is used to specify Printer parameters to Templates assigned to a Printer.

9]
Add / Change V", &



This will show the Printer Parameters screen to add or change settings.

Delete %

This will remove the saved Printer Parameters.

Assign Directory
The options below are for assigning a Directory to the selected Printer.
If a data file from this location is selected it will be printed on this Printer.

Add ¥
Add a new Directory

9]
Change &
Change the selected Directory

Delete %

Deletes the selected Directory assignment.



This screen is used to specify Printers other than the Default Printer

Once a Printer is added it will appear in the Advanced Printer Setup area of the Printers tab in the System Setup
screen.

Options

Printer
This is where the Printer can be selected. See the Printer Support topic for more information.

Port
The port for the selected printer can be selected or typed in. See the Printer Support topic for more information.

Print Front Side As Back

This option inverts either the sequence or orientation of the items when printing Front and Back sides of a
Product.

This option is not available for the following printers:

T6112DS

Cutter
Enable this if a Cutter is attached to the printer. Some printers error if a cut command is received and no Cutter is
present.

Use Default Windows Printer
When enabled the Windows Printer will print to the default printer specified in the Windows Control Panel.

When disabled a prompt to select the printer will be shown at Print time.

This option is only available for the following printers:

Windows Printer

Copy Front Side Data To Back Side
This will automatically copy data entered on the Front Side of a Product to the Back Side.

This option is only available for the following printers:

T6112DS
Double Print Optimize
When enabled, using compatible firmware and a correctly configured printer, wastage between print jobs can be

eliminated.

This option is only available for the following printers:

T6112DS

Contact Technical Support for more information on how to configure this option.



Assign Product To Printer

This screen is used to specify Templates to be assigned to a specific Printer.

Options

This screen is similar to Add Product screen allowing users to select the Template.

For multiple Templates to be configured to a Printer the All Sizes, All Derivatives, All Colors and All Sides options
can be used.

Once added it will appear in the Advanced Printer Setup area of the Printers tab in the System Setup screen.




Printer Parameters

This screen is used to specify Printer parameters to Templates assigned to a Printer.

The parameters screen contains all options available to be configured.
This screen will show similar options to that in the Print screen.

Options available will be dependent on the Printer selected.
See the Print screen section for more information on the commands functionality.



Directories

The Directories tab of the System Setup screen screen is used to specify default file locations.
All locations can be changed by selecting their corresponding Browse button.

Options

Data

This is the default location of the data files. This Directory must be available for all users who wish to use the
program.

Import
This is the default location used for data files used in the Import screens.

Graphic
This is the default location used when using graphics in a My Product.

Database Printing Job File
This is the default location of Job files used in the Database Printing screen.

Filter
This is the default location of the Filter files use in the Advanced Print screen.

Print Log
This is the default location of the Print Log files created when using the Print Log option.



The Options tab in the System Setup screen is used to specify various options.

Options

International

Language
The language that the program screens are be displayed in can be selected. The following are
available:

Chinese

Deutsch (German)
English

Espaiiol (Spanish)
Francais (French)
Italian

Japanese

Korean
Nederlands (Dutch)
Norsk (Norwegian)
Portuguese (Brazil)
Russian

Turkish

Units
The units of measure used in the program are in mm or inch.

Serialization Characters
This option allows the user to change the default Number (Numerical) and Letter (Alpha) Serialization
characters. See the Sequential Numbers And Letters topic for more information.

These should not be changed unless the user needs to Print either the $ or @ character. Whatever
characters are used for Numerical or Alpha Serializations cannot be printed.

Font

Default Style
This sets the default Font Style to be used in the Add Product screen.

Default Size
This sets the default Font Size to be used in the Add Product screen.
If the default size is too large for a Product then the closest size to this one will be selected.

Use Only Default Font Style

This option prevents the user changing the Font Style in the Add Product screen. The user can change
the Font Size

Auto Size Font Tolerance
This value is used for Products using the Auto Size Font option in the Add Product screen.
It reduces the allowed area for data, preventing data from being printed outside of the Template.
2 mm is the default recommended value, only change this if data is not printed correctly.

Start With The Last Used File
This will cause the last used data file to be loaded when the program starts.



Edit Order: Down-Across
This option is only effective for the Data Entry Order.
For Import options then select the Import Order: Down-Across in the relevant Import screen.
The image below shows the order the fields will be edited in.

First Second First Third
Third Fourth Second Fourth

Disabled Enabled

Edit Order: Front-Back

This option is only effective for the Data Entry Order. and only affects Double Sided Products and works with

the Edit Order: Down-Across option.

Disabled
All the fields on the Front Side will be processed before the Back Side ones.

Enabled
The order will toggle from Front Side to Back Side for each individual field.

Log Printed Products
This will log all printed Products.

There are two types of log files created. The location of the log files can be configured in Directories tab of

the System Setup screen

Standard Logging
Standard logging creates a log of the Product, Color and Quantity printed.

This log can be accessed via the Print Log command in the Print Tab of the Ribbon.

The file name for this log is called "WT_Print_Log_<PCNAME>.dat"

Advanced Logging
This creates a log file for each month and lists individual print actions created.

The file name for this log is called "WT_Print_Log_Advanced_<YYY-MM-PCNAME > .csv"

The contents of this log cannot be viewed from within the program
It is designed for users to open this in an external program such as Microsoft Excel.

The file will log the following for each print operation

Year
Month
Day

Time

User ( Windows Username )
File
Template
Color
Color Code
Quantity
Printer
Port

Stop After Printing First

This sets the default state for the Stop After Printing First control in the Print and Advanced Print screens.




This option is not available for the following printers:

T6112DS
Windows Printer

Auto Size Length Tolerance
This value is used for Products using the Auto Size Length option in the Add Product screen.
This value is added to the Length of each Item to prevent cutting/perforating too close to the text and making
text unreadable.
2 mm is the default recommended value, only change this if data is not printed correctly.



The View tab in the System Setup screen is used to specify all options related to display and view options.

Options

Selected Product Section
This section is used to configure the columns available in the Selected Product list box.
The order of these columns can be changed by selecting a Column item and using the Move Up or Move
Down button to move it to the desired location.

The Defaults button will select the following fields in the order below:

Template
Type
Lines
Font
Printer
Color
Quantity
Size



The User Access tab in the System Setup screen is used to configure the default options for user access.

This screen allows the default options for Minimum Level and Medium Level passwords to be customized from their
defaults



XMT Import Server

The XMT Import Server tab in the System Setup screen is used to configure the program to act as a server for
importing and printing XMT files.

This allows the program to monitor for new XMT files. The Mode option will determine how the XMT files are
processed.

Options

Enable
This option turns on and off the server.

When enabled the program will minimize the program to the system tray Each time the program is started it
will remain minimized as in the mode the program cannot be used for any other activities.

The program can be maximized by either Left Mouse Double Click on the H E system tray icon or by Right
clicking it and selecting Maximize WinTotal. The XMT server can also be stopped and the program closed by
clicking Exit.

Maximizre WinTotal

About

Exit

When enabled and maximized the Quick Access Controls Tab will show the button Stop XMT Import Server
Quick Access Controls Product Data Entry Print

GORHP R RE -2 e M aa O

Mew Open Save Import Add Change Add Change Print Advanced Manual System Double Zoom Zoom Stop XMT
As ~ Product Product Data Data Print Print  Setup Sided Wiew~ QOut In Import Server

If the Stop XMT Server button is selected the server will be stopped allowing for full use of the program.
XMT files will not be processed until the server is started again by clicking the Start XMT Import Server

Quick Access Controls Product Data Entry Print

JERHAF G PE R % [ 2 a 1

New Open Save Import Add Change Add Change Print Advanced Manual System Double Zoom Zoom Start XMT
As 2 Product Product Data Data Print Print Setup Sided View=~ Out In Import Server

Quick Access Controls

Mode
This option will determine the mode of the XMT Server

The following modes are available

Import
This option will Import the detected XMT file to Data directory specified in the Directories tab of the
System Setup screen.
The filename created will be the XMT files name with an appended date time stamp of -YYMMDD-HH-
MM-SS-sss
This allows for the same XMT file to be imported multiple files to a unique output file.
Files will only be imported if they do not go above the maximum length for a filename ( file and path ) of
252 characters which includes the data time stamp.

Import and Print
The will perform the same operation as the Import mode but will then Print the successfully imported

Products.

Print



This option will Print the detected XMT file without saving any data

Note

If the Data directory specified in Directories tab of the System Setup screen the XMT Import Server will not
start. If the directory is not detected after the server is running the program will terminate.

Disable All Fields In Print Screen
If enabled when the Print screen appears all options will be disabled. All values must be configured in the
Advanced Printer Setup option in the Printers tab in the System Setup screen.

Disable All Fields In Print Screen
This option will disable the Print screen prompt being shown.
Any XMT files detected will be processed and the printed as defined in the Advanced Printer Setup option in
the Printers tab in the System Setup screen.
This solution should only be used if all Templates defined in a XMT file are mapped..
If incorrectly configure large amounts of wastage can occur.

Delete XMT File After Import
This option will Delete the XMT file as soon as it is printed.

Move XMT File To Specified Directory After Import
This option will Move the XMT file as soon as it is printed to a specified Directory.

Directory
The location of where the program will monitor for XMT files and the location of where printed XMT files will
be placed can be viewed and changed in the Directory areas by either using the Browse options or typing the
path in manually. Entering a location that does not exist will create a new one.



This will display the Help file. To go directly to a topic based on the programs current screen press F1.



This option is enabled only if passwords have been created in the User Access tab in the System Setup screen screen.

It allows the user to log off their current password level without having to Exit the program completely.



This option will close the program. This can also be done via the X icon in the Top Right corner of the screen.



This is the new standard for programs to display commands and features that were previously in a toolbar.
The following tabs are available:

Quick Access Controls Tab
Product Tab

Data Entry Tab
Print Tab

Data Entry Keypad Tab - this is only available when editing data.

Note

These controls can be added to the Quick Access Toolbar for quick access.

For more information please read the following topics:

Screen Overview



Quick Access Controls Tab

This is the tab used to contain the most common features.

The commands here originate from one of the other tabs or File Button.

Command Original Location
New File Button
Open File Button
Save As File Button
Import Data Entry Tab
Add Product Product Tab
Change Product Product Tab
Add Data Data Entry Tab
Change Data Data Entry Tab
Print Print Tab
Advanced Print Print Tab
Manual Print Print Tab
System Setup File Button
Double Sided View Product Tab
Zoom Out Product Tab
Zoom In Product Tab
Note

These controls can be added to the Quick Access Toolbar for quick access.

For more information please read the following topics:

Screen Overview



Product Tab

This is used to display commands relating to Products.
The following ribbon panels are available:

Product Panel

Templates Panel

View Panel

Note

These controls can be added to the Quick Access Toolbar for quick access.

For more information please read the following topics:

Screen Overview



Product Panel

This is used to display commands relating to Products.
The following ribbon controls are available:
Add Product
Change Product
Delete Product
Pr t

Note

These controls can be added to the Quick Access Toolbar for quick access.

For more information please read the following topics:

Screen Overview



This option is used to select the Template and settings required to create a Product.
This option is divided into 2 screens.

Screen 1
Screen 2



Options

Family
The buttons on the top of this screen can be used to filter the Template available in the grid

‘I I‘ Sleeve - this is for all Heat Shrink Sleeves.

Cable Marker - this is for Cable Markers that are fixed using cable ties.

Label - this is for all Die Cut and Continuous Labels
Si? Favorites - this is for showing only Templates assigned as Favorites. See the Favorites section below.
MY Designs - this is for user created designed.

Favorites
Any Template in the Sleeve, Cable Marker or Label filter sections can be assigned as Favorites.
They can be assigned or removed by clicking the star icon. If any Favorites are defined this will be the
default button type used when this screen is entered.
These can only be enabled and disabled in the original filter type used not in this section.

Template
Once the filter type has been selected a list of all items in this will be displayed.

If MY Designs was selected then a list of the Name and Type of these will be shown. All other options will
show Type, Size and Derivative options.

Select these items to match the name found on the box/package of the product to print. If required this list
can be filtered using the down arrow buttons

Color
This allows the Color of the Template to be selected, only available ones will be shown.

Auto Size
This option has three options available:

None
This does not apply any Auto Size settings

Font
This option will allow a best fit font size to be selected based upon the data entered.

Length
This option is only available for Sleeve Templates that are configured to be Continuous. This allows
each Item to have its Length calculated based upon the Length of the data used making it as small as
possible.

Note

This feature is only available for the T6112DS Printer if the Double Print Optimize option is enabled
and the Printer supports this feature. Contact Technical Support for more information on how to
configure this option.

Double Sided
This allows data to be created separately for both the Front and Back sides.



Rotate Back Side 180°

This option is enabled when selecting the T6112DS Printer. This rotates the Back Side data 180° if Double
Sided is selected.

Auto Numbering Product
This option will allow an Auto Numbering Product to be created. This will only allows 1 Item to be created.
When Sequential Numbers And Letters are added they will be remembered when printed and Print the next
Item from the next value. For more information see the Sequential Numbers And Letters section.

When Auto Numbering Product is selected then the following options are visible.

Update Counters After Print
This will update the counter to start from the next value when next printed. If not selected the counter will reset
to the original Base value. For more information see the Sequential Numbers And Letters section.

Prompt After Printing Product
This will prompt the user after printing to confirm if all Items were printed correctly before updating the
counters. If unselected then no prompt is shown and the counter update will be applied automatically.



Options

Lines
This option allows the user to select the number of text Lines required.

Font Style
The Windows True Type font can be selected here. Arial and Courier New are the recommended fonts but any
can be selected, see Font Selection topic for more information about fonts.

Font Size
This shows the available point sizes for the selected font. The values allowed are shown in brackets. The
allowed values will vary depending on the dimensions of the Template and the Lines fields.
If the Auto Size Font option was selected in the first screen then the Font Size control will be used as the Font
Minimum and a new control called Font Maximum will be displayed. When selected the font size will be
configured to the maximum size that allows the data to fit, limiting it between the minimum and maximum
values.

Bold B
This option which gives a darker mark when printed. This is recommended for most applications.

6 and 9 underlined 99

This will underline the numbers 6 and 9. This allows the correct orientation of the character to be determined.
Eg6and 9

Italic I
This will set the font to Italic

Underline U
This will set the font to Underline

Inverse *G
This will Inverse the text. It will not inverse print the complete area.

Rotation

This section allows the Rotation of the text to be selected.
Raoktation

abc

abc g oqe

0°, 90°, 180° and 270° options are available in most cases but some options may be disabled if they can not
be supported.



Alignment

The alignment options determine the Horizontal Align and Vertical Align options.
Alignment

I I

The first row configures the Horizontal Align - options are Left, Center or Right.
The second row configures the Vertical Align - options are Top, Center or Bottom.

Note

In some cases not all options will be selectable or applied.

Length Section
This section is displayed for Templates that are defined as Continuous unless the Auto Size Length

option is selected.
Length

—# | = Length

O sgm
111 f
B

Length
This allows the Length to be entered.
The minimum allowed value is 5.0mm or 0.195 inches.
mm or inch will be displayed depending on the Units set in the Options tab in the System Setup
screen.

Diameter O
This allows the Diameter to be entered. This option is not available for Sleeve Templates
The minimum allowed value is 1.6mm or 0.063 inches.
Using the formula pi x Diameter the Length will then be calculated.

11

Repeats Eif

This option is available for Label Templates that are defined as Continuous.
It allows entered data to be repeated along the Products Length a specified number of times
without the data having to be entered multiple times.
This option is only enabled base on the rules below.

o Length is equal or greater than 50mm or 1.967 inches

o Diameter is equal or greater than 15.9mm or 0.626 inches
Minimum Repeat Distance

This option can be used to customize the space between Repeats

Max Characters Per Field
This option shows the maximum characters allowed to be entered onto the Product. This is an accurate figure
for Courier New however for other fonts it is an approximate value. See Font Selection for more information.



Change Product

This screen is identical to the Add Product screen and allows the current Selected Product to be changed.

Caution should be used when using the option. Data may be lost or truncated if the new Product has fewer or
smaller data fields.



Delete Product

This option will list all Products in the data file.
The current Selected Product by default will be checked.

All checked products and its associated Data to be deleted.



Copy Product

This option allows a Product and its data to be copied from one data file to another one. It is only enabled when a
Product is selected.

When selected a Open screen allows the Destination File to be selected.
Once selected then the Copy Product screen displays the Product, Source File and Destination File



emplates Panel

This is used to display commands relating to Templates.

The following ribbon controls are available:

TE Layouts
MY Designs

Note

These controls can be added to the Quick Access Toolbar for quick access.

For more information please read the following topics:

Screen Overview



E Layouts

This screen displays a list of the pre installed TE Layouts.

The screen has no functionality other than looking up ALL TE Layouts without checking for Printer compatibility to get
the full Name of the layout for use in XMT files.

You can also add and remove Favorites

For more information please read the following topics:

Add Product



This screen is used for all user created designs that do not come pre-installed with the program.

Created designs will appear in a grid with the following information is shown.
Name
This is the user created name for the design.

Type
This is the design type. The following types are available
MY Layout

My Product
My Product - Formatted -this is a My Product where Formatting has been applied.

Base Layout
This shows the name of the original layout the design was created on. It is not populated for any MY Layout

designs.
Color
This shows the Color selected when the design was created. It is not populated for any MY Layout designs as
they can have more than 1 Color defined
Printer
This shows the Printer configured when the design was created. It is not populated for any MY Layout
designs as there could be multiple Printers
Font
This shows the Font selected when the design was created. It is not populated for any MY Layout designs.
Auto Size

This displays Font when the design was created with the Auto Size Font option. It is not populated if this
option was not selected or for any MY Layout designs.

Double Sided
This shows the Double Sided option selected when the design was created. It is not populated for any MY
Layout designs.



Options

Add ¥

This allows for creation of a new design

The user must enter a unique name to call the design and select one of the design types.
MY Layout

My Product

Hame ‘

(®) MY Layout
()M Product

[ 9]
Change O
This allows the currently selected MY Layout or My Product to be changed.

Delete %

This will Delete the currently selected item. - WARNING - only Delete if this layout is no longer required and
no data files are using it.

Save As H

This will ask the user for a new Name to save the currently selected item as.

Export ‘]

This will Export all of the designs to a file.

Import ¢
This allows a file created using the Export command to be imported.

Once a file has been selected the MY Designs - Import screen will show a preview of what will be imported.
If any of the items are not allowed to be imported then the reason why is displayed in the Error column.

For more information please read the following topics:

MY Designs - Import



MY Layout

This is the name used for user created layouts.

Only create new layouts if it is not possible to use a layout pre-installed in the program. See the TE Layouts topic.
The screen is used to configure the layouts and is divided into 3 tabs.
Dimensions

Appearance
Printers



The Dimensions tab of the MY Layouts screen is used to create/edit the dimensional properties of the layout.

Options

Width
The Width of an individual layout can be from 3mm to 500mm or 0.12inches to 19.6 inches.

Height
The Height of an individual layout can be from 3mm to 500mm or 0.12inches to 19.6 inches.

Printable Area
The Height and Printable Area are most often the same. Entering a Height, will automatically set the
Printable Area field to that value. The values can be different if the actual Printable Area of the layout is less
than the total Height.

Number Across
The total number of columns across a row should be entered in this field.

Rows Per Page
This Rows Per Page field is needed for layouts that are Sheet based. Layouts not separated on individual
sheets should have a value of one in this field (if it is displayed).

Horizontal Pitch
This value is only necessary if the Number Across value is greater than one. For layouts with multiple columns,
the entry is the sum of the Width and the gap between each across (the measurement from the Left edge of
one column to the Left edge of the next column immediately to its Right). If there is no gap, the Horizontal
Pitch will equal the Width.

Vertical Pitch
This value is the sum of the Height and the gap between each row (the measurement from the Top edge of
one row to the Top edge of the row immediately beneath it). If there is no gap, the Vertical Pitch will equal
the Height.

Top Margin
This is the default Top Margin value that will be displayed in the Print screen. This can be overridden at Print
time.

Left Margin
This is the default Left Margin value that will be displayed in the Print screen. This can be overridden at Print
time.

Continuous
This is used to define the layout as Continuous

Double Sided
This is used to allow the Product to be created as a Double Sided one.

Show Information
This will show Information symbols on the preview of the design to help understand the dimensions required.



This Appearance tab of the MY Layouts screen is used to create/edit the visual appearance of the layout.

Options

Colors

This is an option used for accurate visual display. It has no effect on printing. One or more Colors can be
specified.

Rotation

This will allow the Rotation of the text to be selected. 0° 90°, 180° and 270° options are available where the
Product and Printer allow.

WYSIWYG
This stands for What You See Is What You Get.
This is a common computing term used to show that the screen will display as per output.

This option will enable a predefined WYSIWYG display for the layout. This will result in a display showing the
layout to scale along with is preview showing the Color, carrier, tractor feed holes etc.

If disabled a rectangular box will be displayed showing only the data. This option has no affect on its output to
a Printer.



The Printers tab of the MY Layouts screen is used to create/edit the Printers allowed to use the layout.

As default the Default Printer in the Printers tab in the System Setup screen will be added.

Options

Add
This will display a Select Printers For Layout screen where a list of Printers available to be added will be
displayed.

Remove

This will remove a selected Printer from the Allowed Printers list.

Remove All
This will remove all Printers from the Allowed Printers list.

Cut
This will allow the Printer to cut the layout.

Printer Setup
This option is only available for T312M and T312Mi Printers. If one of these is selected it will enable the
Printer Setup screen button.



The Select Printers For Product is screen is used to select which configure the models allowed for this layout.



The Printer Setup screen is used to select options for the selected model.

Options

High Energy ,
This option gives a higher energy value to the head giving improved mark performance.

This option is only available for the following printers:

T312M
T312Mi

Half Speed

This option when High Energy is selected, slows the printer down by half to help give even further improved
mark performance.

This option is only available for the following printers:

T312M
T312Mi



MY Product

This is the name used for user created Products.

A MY Product is based upon either a TE Layouts or MY Layout with all the parameters set in the Add Product screen
to make a Product.

Once created the user can just select a MY Product name to select the Product rather than have to configure it every
time it was used.

Creating and editing these can be done in the MY Pr t Configuration screen.



The MY Product Configuration screen is used to create or edit a My Product.

A MY Product is based upon either a TE Layouts or MY Layout with all the parameters set in the Add Product screen
to make a Product.

Once created the user can just select a MY Product name to select the Product rather than have to configure it every
time it was used.

Options

The options on this screen are similar to those in the Add Product screen with the following differences.

Auto Numbering Product
This option is not visible when creating or editing a My Product. It is available when used in the Add Product
screen.

Default Lines Per Template
This is only visible when creating a MY Product
When enabled the rules for calculating the number of Lines is the same as the Add Product screen.
When disabled the number of lines is extended to 100 regardless of the Templates dimensions.

Formatting
This feature allows Advanced Formatting to be applied to a MY Product. This can be used if the design
requirements are not selectable in the Add Product screen are required.

This feature has many possible uses, for example.
¢ Having different font types and sizes on different fields.
e Adding Barcodes with fixed data or data linked to data fields in the program
¢ Adding Graphics, lines, circles or rectangles

% % | The Advanced Formatting button will open the Advanced Formatting module for the design to be
% edited. Please refer to the help topic in that module for more information.

Once the editing is completed and saved the Change MY Product screen will show the design.
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Once the wizard is completed the design will be the My Product - Formatted Type.

Changing this type will only show the design screen not the screens used to create the product.

2y | The Advanced Formatting - Remove button will remove any Advanced Formatting and return the
m design to a MY Product Type. The product can then be recreated using different values.

Note

This option is only available when creating a MY Product
This option is not selectable if the Auto Size Length option is selected.



This screen shows a preview of what MY Designs will be imported by using the Import option in the MY Designs
screen. ltems that cannot be imported then the reason why is displayed in the Error column.

Errors and their solutions are below.

Existing
MY Layouts or MY Products will not be imported if one exists with the same name.

Solution
Delete the MY Layout in the MY Designs screen.

Note

It is recommended to make a backup of the original using the Save As option in the MY Designs screen
before deleting any items.

Existing - Based Upon
MY Products based upon a MY Layout will not be imported if there is an existing MY Layout with the same

name.

Solution
Delete the MY Layout in the MY Designs screen.

Note

It is recommended to make a backup of the original using the Save As option in the MY Designs screen
before deleting any items.

PC Number
MY Layouts are encrypted to the computer and license they were created on.
If this error is shown then this file has been created on a different computer.

Solution
Please email he Global Email Support email found in the Technical Support topic providing the
following information

1. A copy of the file you are trying to import.
2. A screenshot of the About screen or the text for the USB Hardware Key and PC Number. These
fields can be selected and copied to clipboard from the About screen.

Technical Support can then encrypt the file with the new computer information to then allow you to
successfully import it and send it back to you via email.

PC Number - Based Upon
MY Products based upon a MY Layout using a different computer. See the PC Number section above
If this error is shown then this file has been created on a different computer.

Solution
Please email he Global Email Support email found in the Technical Support topic providing the
following information

1. A copy of the file you are trying to import.
2. A screenshot of the About screen or the text for the USB Hardware Key and PC Number. These
fields can be selected and copied to clipboard from the About screen.

Technical Support can then encrypt the file with the new computer information to then allow you to
successfully import it and send it back to you via email.



This is used to display commands relating viewing Products.
The following ribbon controls are available:

Double Sided View

Zoom Out

Zoom In

Note

These controls can be added to the Quick Access Toolbar for quick access.

For more information please read the following topics:

Screen Overview



Double Sided View

This button has several functions, pressing the Double Sided View button will show Front and Back sides of a
Double Sided Product side by side.

Pressing the Arrow will open a sub menu with the following commands:

Front
This will only show the Front Side data.

Back
This will only show the Back Side data.

Both
Both

This is the same as the Double Sided View button showing both Front and Back sides of a Double Sided
Product side by side.

Note

This is only available if a Double Sided Product is in the Selected Product.



The can be used to change the zoomed view of a Product.

These settings are saved for each Product.



The can be used to change the zoomed view of a Product.

These settings are saved for each Product.



Data Entry Tab

This is the tab used to display commands relating to Data Entry.
The following ribbon panels are available:

Data Panel
Search Panel

Note

These controls can be added to the Quick Access Toolbar for quick access.

For more information please read the following topics:

Screen Overview



Data Panel

This is used to display commands relating to Data.
The following ribbon controls are available:

Add Data

Change Data
Insert Data

Delete Data

Copy Data

Move Data

View Serializations
Constants

Import

Note

These controls can be added to the Quick Access Toolbar for quick access.

For more information please read the following topics:

Screen Overview



This command is available when a Product has been created and is used to enter data.
Once this option is selected then data can be added.

Options

When in data entry mode most options in the File Button will be disabled but the following sections can be used.
Ribbon

When editing data the standard Ribbon is replaced with the Data Entry Keypad Tab

Item
A individual item is called a Item.
These are automatically numbered starting at 1.

Once the data the first field/Item is created pressing the Enter key on the keyboard will advance to the Next
Field or Item.

The order the fields are entered into as default is Across then Down. This can be changed. See the Data Entry
Order topic for more information.

A Item is saved when the next Item is entered. To exit this mode enter into a new empty Item and press the
ESC button on the keyboard or select the Quit Data Entry button on the Data Entry Keypad Tab.

Quantity
As default a Item quantity (Quantity) of 1 is added. This is number of times an individual Item will be printed.
If different quantity values for individual Items are required then select the Edit Quantity check box in on the
Data Entry Keypad Tab. Then the user is prompted to enter the Quantity for each Item.

To change the quantity of an existing Item, select the Item and click in the Quantity area. The quantity field
will become an entry box with the current quantity listed. Type the new quantity then press the Enter button.

Repeats

This field appears when a Label Template that is defined as Continuous and the Repeats option is selected in
the Add Product screen.

It will allow entered data to be repeated along the Products Length a specified number of times without the
data having to be entered multiple times.

For more information please read the following topics:

Data Entry Keypad Tab



Change Data

This command is available when a Product has been created and has data.

This option will allow data to be edited. This has the same functionality as the Add Data button.
This option is only available if a Item or multiple Items are selected.

Editing can also be achieved by double clicking each Item.

For more information please read the following topics:

Mouse Operation



Insert Data

This command is only available if one Item is selected.
This allows a new Item to be inserted before the selected Item.
The Ins key on a keyboard can also implement this feature

For more information please read the following topics:

Mouse Operation



Delete Data

This command is available when data is present on a Product and allows Items to be deleted.

If any Items are selected when using this command is used then the Delete screen defaults to the Selected option
which will Delete only selected Items.

If no Items are selected with the Range option is selected which can then be used to specify which to Delete.
The Maximum text will display the maximum values that are allowed.
The Delete key on a keyboard can also implement this feature

For more information please read the following topics:

Mouse Operation




Copy Data

This command is available when data is present on a Product, allowing Items to be copied within the current Product.
The screen allows the From and To options to be specified for the Items to Copy.

The Insert Before option is used for the insertion point for the copied data to be placed.

If a Item is selected it will be automatically added as the insertion point.

The Maximum text will display the maximum values that are allowed.

For more information please read the following topics:

Mouse Operation



This command is available when data is present on a Product and allows Items to be moved within the current
Product.

The screen allows the From and To options to be specified for the Items to Move.

The Insert Before option is used for the insertion point for the copied data to be placed.
If a Item is selected this will automatically added as the insertion point.

The Maximum text will display the maximum values that are allowed.

For more information please read the following topics:

Mouse Operation




View Serializations

This command is available when a Item is selected that has Serialization data.

For more information please read the following topics:

Sequential Numbers And Letters



This screen is available to configure the F7, F8, F9 & F10 constant keys that can be used to insert frequently used
words or phrases.

If data is configured for the buttons this data will be shown on the Data Entry Keypad Tab when editing Items.

Note

These controls cannot can be added to the Quick Access Toolbar for quick access.

Example
Configuration

Constants

Enter ¥our Required Constank Text For The
Function keys

F7 | Conskant

Fa | Can Be Inserted

|
F& | Data |
|
|

F1o | Here

| O I | Cancel |

Display

Data
Constants

Can Be Inserted




This button has several functions, pressing the Import button or the Arrow will open a sub menu with the following
commands:

Import Ascii Text
Import XMT

Import Database
Database Printing

For more information please read the following topics:

Getting Data From External Sources



Import Ascii Text

This screen is used to Import Ascii Text files.

The screen is divided into 2 tabs
Ascii Text Tab

Options Tab

For more information please read the following topics:

Getting Data From External Sources



The Ascii Text Tab is used to specify the Input and Output File.

Options

Input File Group

=
Open
This is used to select the directory and file to import. The default directory to be used can be specified
using the Import option in the Directories tab of the System Setup screen.

Output File Group

New  ©
This will display the New screen.

Open —
This will display the Open screen.

Selected Product
This section shows the currently selected Product.

Selected Product

Template " Type H Lines " Font ” Printer A
SCE 3/32-2.00 TE Laynout il 10 pt, Arial TE3124

< >

For more information see the Selected Product topic.

Add Product ‘Hr
This button will display the Add Product screen.

HY
Change Product <H
This button will display the Change Product screen if a Product is selected.

Delete Product %
This button will delete the Selected Product

Append Data
This option is only available if a Item is selected before using the import option and allows new data to
be added at the end of the existing data.

Insert Data
This option is only available if a Item is selected before using the import option and allows new data to
be inserted before the selected Item.

Generic Options

Preview
This option will display the Preview screen. This is useful to check the settings used.

Import and Open
This option automatically opens the Output File after the import is completed.

Import
This will Import the Input File

For more information please read the following topics:

Getting Data From External Sources
Mouse Operation



The Options Tab is used to configure the Import Ascii Text options.

Options

Input File Options Group

Skip First Line
This option does not Import the first line of the file. This is useful if the file contains header information
not required to Print

Import Order: Down-Across
Scored Products are read by default from left to right one line at a time or one score at a time from top
to bottom. This option changes this to left top to bottom then right top to bottom. See the Data Entry
Order topic for more information.

One Field Per Line
A Item with more than one field (multiple lines or scores) can be separated on different lines using this
option. It may be necessary to also use the Field Separator depending on the file type.

Ignore Line Breaks
This option ignores all delimiters and line breaks and imports the file as a list.

Field Separator
This allows selection of standard Field Separator to identify different fields in the Input file.
Comma, Tab and Semicolon are available for selection. There is also an option to select a custom one
by selecting User Defined and typing in the required separator.

Quantity Field
This option specifies which field in the input file is used for specifying the number for the Quantity field
in the Add Data screen.

Physical Lines Per Logical
This allows the user to create a Product with for example 3 lines but only Import data on the first 2,
leaving the last line empty for editing.

Generic Options

Preview
This option will display the Preview screen. This is useful to check the settings used.

Import and Open
This option automatically opens the Output File after the import is completed.

Import
This will Import the Input File

For more information please read the following topics:

Getting Data From External Sources



Import XMT

This screen is used to Import XMT files.

XMT files are fully specified input files.
They contain Product, Font, Data and Quantity. allowing users to Import the correct data without mistakes.

The screen is divided into 2 tabs
XMT Tab

Options Tab

For more information please read the following topics:

Getting Data From External Sources
XMT Files



The XMT Tab is used to specify the Input and Output File.

Options

Input File Group

=
Open
This is used to select the directory and file to import. The default directory to be used can be specified
using the Import option in the Directories tab of the System Setup screen.

Output File Group

=
Open
This will display the Open screen.

Append Data
This option is only available if a Item is selected before using the import option and allows new data to
be added at the end of the existing data.

Insert Data
This option is only available if a Item is selected before using the import option and allows new data to
be inserted before the selected Item.

Generic Options

Import and Open
This option automatically opens the Output File after the import is completed.

Import
This will Import the Input File

For more information please read the following topics:

Getting Data From External Sources
Mouse Operation



The Options Tab is used to configure Import XMT options.

Options

Input File Options Group

Import Order: Down-Across
Scored Products are read by default from left to right one line at a time or one score at a time from top

to bottom. This option changes this to left top to bottom then right top to bottom. See the Data Entry
Order topic for more information.

Output File Options Group

Alignment

The alignment options determine the Horizontal Align and Vertical Align options.
Alignment

I

The first row configures the Horizontal Align - options are Left, Center or Right.
The second row configures the Vertical Align - options are Top, Center or Bottom.

Note

In some cases not all options will be selectable or applied.

Generic Options

Import and Open
This option automatically opens the Output File after the import is completed.

Import
This will Import the Input File

For more information please read the following topics:

Getting Data From External Sources



Import Database

This screen is used to Import Database files.

The screen is divided into 2 tabs
Database Tab

Options Tab

For more information please read the following topics:

Getting Data From External Sources



The Database Tab is used specify the Database and Output File

Options

Database Group

=~
Open —
This button will open the Database Connections screen. Here new connections can be created, edited,
selected/unselected and deleted.

Connection Name
This section shows information about the database connection being used. This information will vary
depending on the connection type. The Connection Name is always used followed by key information about
the connection.

Output File Group

New | ©
This will display the New screen.

=
Open
This will display the Open screen.

Selected Product
This section shows the currently selected Product.

Selected Product

Template Type Lines Font Printer A
SCE 3/32-2.00 TE Layout i 10 pt. Arial TEZ124
< >

For more information see the Selected Product topic.

Add Product ‘l |r‘
This button will display the Add Product screen.

HY
Change Product 1!
This button will display the Change Product screen if a Product is selected.

Delete Product %
This button will delete the Selected Product

Append Data
This option is only available if a Item is selected before using the import option and allows new data to
be added at the end of the existing data.

Insert Data
This option is only available if a Item is selected before using the import option and allows new data to
be inserted before the selected Item.



Generic Options

Preview
This option will display the Preview screen. This is useful to check the settings used.

Import and Open
This option automatically opens the Output File after the import is completed.

Import
This will Import the Input File

For more information please read the following topics:

Getting Data From External Sources
Mouse Operation



The Options Tab is used to configure Import Database options.

Options

Input File Options Group

Import Order: Down-Across
Scored Products are read by default from left to right one line at a time or one score at a time from top
to bottom. This option changes this to left top to bottom then right top to bottom. See the Data Entry
Order topic for more information.

Records Per Item
This option allows the number of records in the database to be specified for the use in one Item.

Generic Options

Preview
This option will display the Preview screen. This is useful to check the settings used.

Import and Open
This option automatically opens the Output File after the import is completed.

Import
This will Import the Input File

For more information please read the following topics:

Getting Data From External Sources



This screen is used to Print data from a Database without importing the data to a file. To Import and save the data
please use the Import option.

Database Printing Job File Group
Job files are used to store a Database Connection with a Product.
This file can then be opened allowing the data from the Database Connection to be printed on the configured
Product without the data being imported and saved to a data file.

N
Open
This is used to select the Directory and Job file to open.
These files are saved by default in the location specified in the Database Printing Job File option in the
Directories tab of the System Setup screen tab of the System Setup screen.
New ¥
This is used to create a new Job file. Once a Job file is created the Database Job File Setup screen will
be displayed allowing for the files configuration to be made.
[ o)
Change &

This is used to modify the currently loaded Job file and will display the Database Job File Setup screen.

Save As M

This will allow the current Job file to be saved to a new location and name.
Database

Connection Name
This section shows information about the database connection being used. This information will vary
depending on the connection type. The Connection Name is always used followed by key information about
the connection.

Selected Product

This section shows the product currently defined in the Job file.
Selected Product

Template || Type H Lines ” Font H Printer
* SCE 3/32-2.00 TE Layout 1 10 pt. Arial TE3124
< >

Generic Options

Print
This will Print the Job

For more information please read the following topics:

Getting Data From External Sources
Database Job File Setup



This screen is used to configure Database Printing Job files.

The screen is divided into 2 tabs
Database

Options

For more information please read the following topics:

Getting Data From External Sources



The Database Tab is used specify the Database and Product used in the Database Printing Job files.

Options

Database Group

-
Open
This button will open the Database Connections screen. Here new connections can be created, edited,
selected/unselected and deleted.

Connection Name
This section shows information about the database connection being used. This information will vary
depending on the connection type. The Connection Name is always used followed by key information about
the connection.

Output File Group
Add Product \HF’
This button will display the Add Product screen.
H>»

Change Product <!
This button will display the Change Product screen if a Product is selected.

For more information please read the following topics:

Getting Data From External Sources



The Options Tab is used to configure the Import Database options for the Database Printing Job files.

Options

Input File Options Group

Import Order: Down-Across
Scored Products are read by default from left to right one line at a time or one score at a time from top to

bottom. This option changes this to left top to bottom then right top to bottom. See the Data Entry Order
topic for more information.

Records Per Item
This option allows the number of records in the database to be specified for the use in one Item.

For more information please read the following topics:

Getting Data From External Sources



Search Panel

This is used to display commands relating to Data.
The following ribbon controls are available:

Find
Replace

Note

These controls can be added to the Quick Access Toolbar for quick access.

For more information please read the following topics:

Screen Overview



The Find option allows data within a Product to be searched for.

The CTRL + F keys on a keyboard can also implement this feature

The screen displays the From and To options which are used to specify search Range.
The Maximum text will display the maximum values that are allowed.

The Find What section is used to enter the data to search for.

The Match Case option makes the search only find data that matches the upper and lower case characters in the Find
What section.

When data is found the Find Results screen is shown.



The Find Results screen will show any data found from the Find command.
The Find Next button will search for the next Item.
The New Search button will return to the Find screen to allow a new value to be entered.

If no data or no more data is found a Warning screen is shown.



The Replace option allows data within a Product to be searched for and replaced with new data.
The CTRL + H keys on a keyboard can also implement this feature

The screen displays the From and To options which are used to specify search Range.

The Maximum text will display the maximum values that are allowed.

The Find What section is used to enter the data to search for.

The Replace With section is used to enter the replacement data.

The Match Case option makes the search only find data that matches the upper and lower case characters in the Find
What section.

When data is found the Replace Results screen is shown.

Note

This function is disabled for Auto Size Length Products.



Replace Results

The Replace Results screen will show any data found from the Replace command.

The Replace button will replace the current Data.

The Replace All button will replace all data matching the Find What with the Replace With data..
If no data or no more data is found a Warning screen is shown.

When the replacement process is completed a screen is displayed showing the No. Of Substitutions made.



This is the tab used to display commands relating to Printing.
The following ribbon panels are available:
Print Panel

Note

These controls can be added to the Quick Access Toolbar for quick access.

For more information please read the following topics:

Screen Overview



Print Panel

This is used to display commands relating to Printing.
The following ribbon controls are available:
Print

Manual Print
Advanced Print

Paper Report
Print Log
Note

These controls can be added to the Quick Access Toolbar for quick access.

For more information please read the following topics:

Screen Overview



This is used to Print a Selected Product.

The Printer being used is shown in the header of this screen.

All values used in this screen will be saved with the Selected Product. They will be remembered for future use.
To reset the values to default the Change Product option in the Product Panel of the Product Tab.

The CTRL + P keys on a keyboard can also implement this feature

The upper area of the screen shows the current layout to be printed.

The Approved Ribbon(s) Ei button displays the Ribbon Matrix ( requires a valid PDF reader to be installed ) where
the correct ribbon for the selected Printer and Product combination can be found.

Options

Positioning Section
This section allows the positioning of the data to be adjusted at Print time.

If the required adjustment has no effect then it may be required to make adjustments on the Printer.
For more information please contact your TE Connectivity representative.

Top Margin
This allows the position of all data on the Item to be moved vertically.
Increasing this value will move the data down and decreasing it will move the data up.
Negative values can be used on some Printers.

Left Margin
This allows the position of all data on the Item to be moved horizontally.
The default value will vary depending on the Printer and Product combination.
Increasing this value will move the data to the Right and decreasing it will move the data to the Left.
Negative values can be used on some Printers.

Back Side Top Margin
This allows the position of all data on the Item to be moved vertically only on the Back Side.
Increasing this value will move the data down and decreasing it will move the data up.
Negative values can be used.

This option is not available for the following printers:

T6112DS

Line Spacing
This option is only available when a Product with more than 1 Line is created. This allows the user to
increase or decrease the vertical space between the Lines.
If a figure too large is entered a warning message will appear.



Selection Section
This section determines which Items are to be printed.

All

This is the default option when printing. When selected, All Items in the current Product will be printed.
Selected

This is only available if Items are selected. When selected only the selected Items will be printed.

For more information please read the following topics:

Mouse Operation
Range

This allows a Range of Items to be printed using the options below.

Item
This allows the user to specify a From and To number Range

Sub Item
This allows the user to select an individual Sub Item position from within the Item Range.

Start Column
This option is available for Products whose Template has more than 1 column of Product per
row. This is the Start Column that is used to Print the 1st Item

Port
This section lists the available Printer ports. The default selection is based upon the values in the Printers tab
in the System Setup screen but can be changed if required. If the required one is not visible please refer to the

Printer Support topic.

Number Of Copies
This option allows the Number Of Copies to be entered. This is the number of times the selected Items are
printed.

Collate =
This option determines the order that the Number Of Copies will be printed.

Example - Number Of Copies is set to 2

! WinTotal !
i 1
! TE Connectivity !

Data



WinTotal

WinTotal

WinTotal

TE Connectivity
WinTotal

TE Connectivity TE Connectivity

Collate On Collate Off

Options

The options button bt can show or hide the options below as they are not commonly used, it does not affect
their functionality).

Speed
This option is available to configure the Speed that the Printer runs.
The values available are dependent on the Printer and the Units value configured in the Options tab in

the System Setup screen.

For more information please read the following topics:

Printer Support

Density
This option configures the darkness of the Print.
Increasing this value will increase the darkness. Lowering this value will reduce the darkness.
The default values are configured depending on the selected Product and Printer combination.

Note

Printer Default settings will use the Density configured in the Printer.

For more information please read the following topics:

Printer Support

High Energy ,
This option gives a higher energy value to the head giving improved mark performance.

This option is only available for the following printers:

T312M
T312Mi

Half Speed
This option when High Energy is selected, slows the printer down by half to help give even further
improved mark performance.

This option is only available for the following printers:




T312M
T312Mi

Printer Mode

This option allows the Printer Mode to be selected.

This option is only available for the following printers:

T312M
T312Mi
Zebra 170xi

Printer Default
This will use the Printer Mode configured in the Printer.

Tear Off
This mode will feed the Product out from under the print head allowing it to be removed.
When the next Print command is sent the Printer feeds the Product back into the Printer.
This mode is NOT recommended for Products using Sleeve Templates as the back and forward
motion of the Printer could cause the Product to jam in the Printer.

Peel Off

This mode enables with the use of an optional sensor to detect when a Product is removed from
the Printer.

Once removed the next Item will be printed and the Printer will then wait for its removal.

Rewind
This mode enables the Product to be set in the correct position to Print the next Item.
To remove the Product from the Printer press the Feed button on the Printer.
This mode is recommended for Products using Sleeve Templates as it eliminates the back and
forward motion of the Printer which could cause the Product to jam in the Printer.

Cutter
This mode enables a Cutter fitted to the Printer to be used.

Sensor

This option can be used to switch the Sensor type being used by the Printer. The recommended sensor
type is automatically selected based on the Product but if required it can be overridden.

Note

Printer Default setting will use the Sensor configured in the Printer.

Leading Zeros

00

This refers to how Sequential Numbers And Letters will be printed.
The selection will Print a zero to the Left of any number that does not fill the field.

Example

| zem Quentty |

- $$ - "B

Data




Serialization Data- 1/ 1

Type | Humerical

Digits | 1

oK Cancel

=
~

10 10

Leading Zeros On Leading Zeros Off
Mirror Print "lL
This option has two different functions depending on the Product.

Scored Product
Scored Product will mirror the data between the different scores.

Example

| Il  Asc oer [ | N asc [ |
Data Entered Printed

Non Scored Product
Non Scored Product the forward slash ("/") character can be used to indicate the separation
of fields and the mirror point.

Example

| [ ABC / DEF | ] \ | [ DEF / ABC | ] \
Data Entered Printed

Reverse Line Order *=*
This will Print multiple lined Items with the Lines in reverse sequence.

1111111111 3333333333
2222222222 2222222222
3333333333 1111111111

Data Entered Printed

Example

Reverse Print Order *l |+



This option reverses the order the Items are printed.

Rotate 180° 1@

This option rotates the printing of the Product by 180° from its original orientation.

Print Cut Line ®:

This option is only available if a Template that is defined as Continuous is selected. It will allow a Cut
line to be printed on the Product.

Print Backide I
This option has two different functions depending on the Product.

Double Sided Product
If a Double Sided Product is selected it will Print the data from the Back Side

Single Sided Product
On a Product that is not Double Sided it will Print the Front data, but in a different way.

This option varies by Printer and can either reverse the Print order rotate the Items 180° at Print
time.

This means the way the Product is loaded into the Printer to Print the Back Side will vary between the
1st Item or last Item.

For more information please read the following topics:

Printer Support

Print Both Sides I‘II
This enables both sides of a Item to be printed at the same time.

This option is only available for the following printers:

T6112DS

Stop After Printing First @)
When enabled the first Item is printed and then the Printed First screen is displayed.
This option can be changed at Print time but the default state is controlled from the Options tab in the
System Setup screen.

This option is not available for the following printers:

T6112DS

Cutter Options
This option is enabled for Printers which either are fitted with or have the option to have a Cutter. This

option will only be visible if the Cutter option is enabled for the Printer in the Printers tab in the System
Setup screen.

When a compatible Product and Printer combination is available then the following Cutter options are
available:

@
Cut - Never g



This option will not cut when the Product is printed.

Cut - Every oo—
This option will cut after every Item is printed.

Cut - Batch 90
This option will cut at the end of every Print batch. Selecting this option can enable the Perforate
(Every) option. When these two options are combined the Printer will perforate between each
Item and at the end it will cut.

Perforate €
This will make the Cutter change from cutting through the Product to only perforating it.

Time
This can add extra time for the perforator to be closed making the perforation deeper

Print Preview
This option will display the Print Preview screen where a preview of how Items will be printed is shown.

Print
This option will begin the printing process.
With the Stop After Printing First option enabled the first Item row will be printed and the Printed First screen
will be displayed.
With the Stop After Printing First option is disabled or the T6112DS Printer is being used then all the Items
for the Product will be printed.

Calibrate
This option is available for some Printers to calibrate it. See the Printer Calibration topic for more information



This screen is displayed if the Stop After Printing First option in the Print screen is enabled.

Options

Reprint First
This will reprint the first Item. This is useful to check if the data is in the correct position and using the correct
options before printing the remainder of the data.

Continue To Print The Rest
This will Print from the remainder of the Products Items.

Cancel
This will quit the screen and return to the Print screen. This option should be used if the values required to
achieve the correct output needs to be changed or the printing aborted.



This screen accessed from the Print screen and allows the user to see a live preview of their data using the options in
the Print screen.

The user can browse through the data using the buttons. It is also possible to resize this screen to allow for better
zooming allowing more or less data to be viewed in one screen.



This screen will display the Add Product screen.
This option is designed for printing data that DOES NOT REQUIRED SAVING.
Once the Product has been selected the program will display the same functions as in the Add Data screen.

Quit Data Entry
This quits the data entry mode but not the Manual Print mode. This allows for editing and data manipulation
to take place without loss of data

When not in Data Entry mode the following options are available.

Add Data

Change Data
Insert Data

Delete Data
Double Sided View
Find

Replace

Change Product
Print

The options below are only available in Manual Print mode.

Options

Clear Data
This option deletes all previously created data in the Manual Print module, leaving the user to enter new data.

Quit Manual Print
This quits the Manual Print mode. All existing Manual Print data will be lost after selecting confirmation in the
warning message.



This screen is used to sort and queue multiple Products to Print.

Correct configurations must be made in the Printers tab in the System Setup screen prior to using this screen.

Options

“~u

Browse |

This allows the currently selected Directory to be changed to another location.
The Products grid will then be updated with Products from this location.

Note

Changing this location will remove all items from the Print Queue

Refresh @

Filter

This will refresh the Products grid with Products from the current location. This may be useful if data is stored
in a network location and other users are adding files.

Note

Selecting this option will remove all items from the Print Queue

When columns in the Products grid are filtered they can be saved for future reference. For example a user can
filter on a specific product so it can be recalled later without having to individually filter each column.

Filter files are saved in the Filter Directory which can be set in the Directories tab of the System Setup screen
Please see the Products topic below.

The following options are available:

Filter
This combo will list any saved filters. Selecting a item will automatically apply the filter.

.

Apply Filter ¥
This will apply the currently selected filter. When a filter is applied this button will have a highlighted
background.

. \ &
Clear Filter ¥
This will clear the current filter from being applied.

N
Delete Filter N
This will delete the filter.

=

Save Filter ¥
This will open the Save Filter screen. Here you can select an Existing filter so overwrite or enter a new
name in the Save As edit box.



Products Grid
This displays valid Products detected in the selected folder.

Products unable to print to the configured printers, Auto Numbering Product and Products with a zero
Quantity will not be displayed.

The grid is automatically sorted by File, Template and Color.

Selecting the filter 1] arrow on each column allows for filtering of grid items and can be saved as a Filter to
be recalled later. See the Filter item in this topic for more information.

Ticked Products can be added to the Print Queue using the Add To Print Queue J’ button.

The columns displayed are the same as in the Selected Product listbox which can be configured via the View
tab in the System Setup screen

Select All [_[EJ

This will select (tick) all items in the Product grid allowing them to be added to the Print Queue

Unselect All [_[E]

This will unselect all items. in the Product grid.

Add To Print Queue l'
This will add all ticked items to the Print Queue.
Products can be added multiple times if required.

Print Queue Grid
This displays Products in order they will be printed.
The order can be changed using the Print Order option.

The columns displays are the same as in the Selected Product listbox which can be configured via the View tab
in the System Setup screen

Move To Start =
This option is only available if the Print Order option is set to User Defined and allows a single selected
Product in the Print Queue to be moved to the top of the grid.

-~
Move Up
This option is only available if the Print Order option is set to User Defined and allows a single selected
Product in the Print Queue to be moved up one position in the grid.

Move Down v

This option is only available if the Print Order option is set to User Defined and allows a single selected
Product in the Print Queue to be moved down one position in the grid

Move To Bottom x

This option is only available if the Print Order option is set to User Defined and allows a single selected
Product in the Print Queue to be moved to the bottom of the grid.

Reverse Queue Order un
This option will reverse the order of the Print Queue



Print Order
The Print Order option allows for the print order for the Print Queue to be defined.

The following options are available:

File

The Print Queue is sorted by File, Template and Color.

Move To Start,Move Up,Move Down and Move To End options are not available for this option.
Product

The Print Queue is sorted for minimal loading and unloading of products in the printer(s).
Starting with the first Template and Color item in the first File, followed by the all other files using this
combination and so on until all combinations are printed.

Move To Start, Move Up,Move Down and Move To End options are not available for this option.

User Defined
This option allows the order of printing to be customised to meet the users needs.

This can be done by either using the Move To Start, Move Up,Move Down and Move To End buttons
or by clicking the column headers to sort the Print Queue.

Load Saved Printer Queue #&
This will load the Print Queue with items used in the Save Print Queue option.
The data folder used to display Products will be changed if the folder used in the Save Print Queue was used
is different to the current one.
Any items that are no longer available will not be loaded.

Save Print Queue &

This will save the current Print Queue so it can be recalled later using the Load Saved Printer Queue button.

0
Delete &

This button has two functions:

1. Selected Print Queue items can be deleted.
2. If no Print Queue items are selected it will remove all items from the Print Queue.

Reverse Print Order

e When Ticked the option will be set ON for all items to be printed

e When Unticked the option will be set OFF for all items to be printed

e When Squared the option will not be set for all items. The option will be determined for each item

individually based on the following hierarchy.
1. If the product has Printer Parameters enabled this value will be used
2. With no Printer Parameters enabled the last value used when printed normally to the assigned printer
will be used.

3. If the Product has not been printed the default values that would show in the print screen are used.

This option reverses the order the Items are printed.

Print Back Side

e When Ticked the option will be set ON for all items to be printed

e When Unticked the option will be set OFF for all items to be printed

e When Squared the option will not be set for all items. The option will be determined for each item

individually based on the following hierarchy.
1. If the product has Printer Parameters enabled this value will be used
2. With no Printer Parameters enabled the last value used when printed normally to the assigned printer
will be used.



3. If the Product has not been printed the default values that would show in the print screen are used.
This option has two different functions depending on the Product.

Double Sided Product
If a Double Sided Product is selected it will Print the data from the Back Side

Single Sided Product
On a Product that is not Double Sided it will Print the Front data, but in a different way.

This option varies by Printer and can either reverse the Print order rotate the Items 180° at Print time.
This means the way the Product is loaded into the Printer to Print the Back Side will vary between the 1st Item

or last Item.

For more information please read the following topics:

Printer Support

Mirror Print

e When Ticked the option will be set ON for all items to be printed

e When Unticked the option will be set OFF for all items to be printed

e When Squared the option will not be set for all items. The option will be determined for each item

individually based on the following hierarchy.
1. If the product has Printer Parameters enabled this value will be used
2. With no Printer Parameters enabled the last value used when printed normally to the assigned printer
will be used.

3. If the Product has not been printed the default values that would show in the print screen are used.

This option has two different functions depending on the Product.

Scored Product
Scored Product will mirror the data between the different scores.

Example

Data Entered Printed
Non Scored Product
Non Scored Product the forward slash ("/") character can be used to indicate the separation of

fields and the mirror point.

Example

| [ ABC / DEF | ] \ | [ DEF / ABC | ] \
Data Entered Printed

Print Product Separator
This option will print a complete row of markers filled with the * character (Asterisks) between different items in
the Print Queue. This can be a useful identifying mark for manually cutting batches of files when printed in one
large print run.

Pause Between Products
This option pauses the printing between Products and gives the user a prompt to load the Product into the correct
printer.

Number Of Copies
This option allows the Number Of Copies to be entered. This is the number of times the selected Items are
printed.



Paper Report

This option will produce a report that can be printed to a Windows Printer.

It will show the Data for the current Selected Product.



This screen will display a summary of the number of Items printed.

This option is only enabled if the Log Printed Products option in the Options tab in the System Setup screen is
enabled

Selecting any line within the log allows that record to be deleted.



Data Entry Keypad Tab

This is a tab that Only becomes visible when editing data via the Add Data or Change Data commands.

The following ribbon panels are available:

Options Panel
Serializations Panel

Constants Panel
Navigation Panel

Note

These controls cannot can be added to the Quick Access Toolbar for quick access.



Options Panel

This is used to display commands relating to Data Entry.

The following ribbon controls are available:

Copy Previous

Copy Previous Line

Copy 1st Score Across Line
Copy 1st Line To All Lines

Mirror Score
Mirror Previous Field
Reverse Line Order

Note

These controls cannot can be added to the Quick Access Toolbar for quick access.



Copy Previous

The Copy Previous (F5) command will copy the previous Itemsdata into the current Item.
Example

Item 1 is entered as below and the next Item is ready have data entered.

WinTotal
By
TE Connectivity

Selecting Copy Previous (F5) produces.
WinTotal
By
TE Connectivity

By
TE Connectivity




Copy Previous Line

The Copy Previous Line (F11) command copies the current line from the previous Item to the current Item.

Example
Item 1 is entered as below and the next Item is ready have data entered.

WinTotal
By
TE Connectivity

Selecting Copy Previous Line (F11) produces.

WinTotal
By
TE Connectivity




Copy 1st Score Across Line

The Copy 1st Score Across Line (F6) command copies the first score data on the current line across the remaining
scores on the current line.

Example
Item 1 is entered as below and the cursor is still in the 1st score.

WinTotal

Selecting Copy 1st Score Across Line (F6) produces.

WinTotal WinTotal




Copy 1st Line To All Lines

The Copy 1st Line To All Lines (F12) command will duplicate the 1st line of the current Item to all lines within that
Item.

Example
Item 1 is entered as below and the cursor is still in the last score on the 1st line.

Selecting Copy 1st Line To All Lines (F12) produces.




The Mirror Score (F2) command has two different functions depending on the Product.

1. If Scored data will mirror between the different scores.
2. If Non Scored data can be mirrored using the forward slash ("/") character to indicating the separation of fields
and the mirror point.

Example - Scored Product
Item 1 is entered as below and the next Item is ready have data entered.

WinTotal TE
By Connectivity

Selecting Mirror Score (F2) produces.

WinTotal
By

TE
Connectivity

WinTotal
Connectivity By

Example - Non Scored Product
Item 1 is entered as below using the "/" option and the next Item is ready have data entered.

WinTotal / By
TE / Connectivity

Selecting Mirror Score (F2) produces.

WinTotal / By
TE / Connectivity

By | WinTotal
Connectivity / TE




Mirror Previous Field

The Mirror Previous Field (F4) command will duplicate the previous fields data and using the forward slash ("/") to
indicating the separation of fields and the mirror point.

Example
Item 1 is entered as below and the cursor is still in the 1st score on the 1st line.

WinTotal / TE

Selecting Mirror Previous Field (F4) produces.

WinTotal / TE

E / WinTotal



Reverse Line Order

The Reverse Line Order (F3) command will duplicate the previous Data into the current Item reversing the lines
order.

Example
Item 1 is entered as below and the cursor is still in the 1st score on the 1st line.

WinTotal
By
TE Connectivity

Selecting Reverse Line Order produces.

WinTotal
By
TE Connectivity

By
WinTotal




Serializations Panel

This is used to display commands relating to Serializations.
The following ribbon controls are available:
Add Serializations

Note

These controls cannot can be added to the Quick Access Toolbar for quick access.

For more information please read the following topics:

Sequential Numbers And Letters
Serialization Data



This screen is available to configure the Type and Digits for creating a Serialization.

It is also possible to make Serializations by typing the Numerical or Alpha characters configured in the Options tab
in the System Setup screen when in data entry mode.

The following types are available.

Numerical
Incremented numbers are created by this option. The number of Digits (maximum of 7) indicates the number
of digits in the largest number to be printed.

Counting from 1 to 9 should have 1 digit (represented by $)

Counting from 1 to 99 should have 2 digits (represented by $$)

Counting from 1 to 999 should have 3 digits (represented by $$$)
Counting from 1 to 9999 should have 4 digits (represented by $$$$)
Counting from 1 to 99999 should have 5 digits (represented by $$$$$ )
Counting from 1 to 999999 should have 6 digits (represented by $$$$$$)
Counting from 1 to 999999 should have 7 digits (represented by $$$$$$$)

The output of Numerical Serializations can be adjusted by using the Leading Zeros option at Print time.

Alpha
Incremented upper and lower case letters can be indicated with this option.
Only a Digits value of 1 is allowed for this option.
Incremented upper and lower case letters are represented by the at sign (@).
This type is case sensitive.

Once a item is fully created then the Serialization Data screen is shown for each Serialization to be configured.

Note

Numerical Serializations limit the Quantity allowed to the number of Digits and will not roll over or continue above
this limit.

Alpha Serializations will NOT limit The Quantity and will roll over through A-Z or a-z depending on the case used.

For more information please read the following topics:

Sequential Numbers And Letters
Serialization Data



This screen is displayed when Serializations are created or edited.

Options

Base
This contains the start or the first number or letter that the Serialization will begin with.

Increment
This is the incremental value that will be added to each number or letter to give the next Serialization value.

Negative
This will make the is the incremental value count in negative or reverse order.

Group
This will divide the number of Quantity by this figure to make duplicate copies of Serializations. This option is
only available if the Group tick box is selected.

Quantity
Once the Serialization Data screens have been completed the Quantity field will be shown where the number
of increments to Print can be set.
This option is not available when using the Auto Numbering Product as the Quantity is defined in the Print
screen.

Note

Numerical Serializations limit the Quantity allowed to the number of Digits and will not roll over or continue
above this limit.

Alpha Serializations will NOT limit The Quantity and will roll over through A-Z or a-z depending on the case
used.



Examples

Example 1 - Numerical Serialization for 1 to 10 counting in steps of 1

Type Numerical
Digits 2

Base 1
Increment 1
Negative Off

Group 1
Quantity 10

Output with Leading Zeros Off
1,2,3,4,5,6,7,8,9,10

Output with Leading Zeros On
01,02,03,04,05,06,07,08,09,10

Example 2 - Numerical Serialization for 1 to 21 counting in steps of 2

Type Numerical
Digits 2

Base 1
Increment 2
Negative Off

Group 1
Quantity 11

Output with Leading Zeros Off
1,3,5,7,9,11,13,15,17,19,21

Output with Leading Zeros On
01,03,05,07,09,11,13,15,17,19,21

Example 3 - Numerical Serialization for 10 to 1 counting in steps of -1

Type Numerical
Digits 2

Base 10
Increment 1
Negative On

Group 1
Quantity 10

Output with Leading Zeros Off
10,9,8,7,6,5,4,3,2,1

Output with Leading Zeros On
10,09,08,07,06,05,04,03,02,01

Example 4 - Numerical Serialization for 1 to 5 with 4 groups of each in steps of 1

Type Numerical
Digits 2
Base 1

Increment 1



Negative Off
Group 4
Quantity 20

Output with Leading Zeros Off
1,1,1,1,2,2,2,2,3,3,3,3,44,44,5,5,5,5

Output with Leading Zeros On
01,01,01,01,02,02,02,02,03,03,03,03,04,04,04,04,05,05,05,05

Example 5 - Alpha Serialization for A to F counting in steps of 1

Type Alpha
Digits 1
Base A
Increment 1
Negative Off
Group 1
Quantity 6
Output

ABCD,EF

Note

To see the values entered for a sequential Item, first select the Item, then use the View Serializations function from the
Data Entry Tab of the Ribbon.

The output of Numerical Serializations can be adjusted by using the Leading Zeros option at Print time.

For more information please read the following topics:

Sequential Numbers And Letters
Add Serializations



Constants Panel

This is used to display commands relating to Constants.
The Constants button will display the Constants screen where the values can be added or edited.
When set their values will be show by the F7, F8, F9 & F10 buttons

Selecting its button or the corresponding F key will insert this data where the text prompt is currently located.

Note

These controls cannot can be added to the Quick Access Toolbar for quick access.



Navigation Panel

This is used to display commands relating to Navigation.
The following ribbon controls are available:

Next Field
Previous Field

Edit Quantity
Quit Data Entry

Note

These controls cannot can be added to the Quick Access Toolbar for quick access.



The Next Field button will advanced the cursor to the Next Field.

The Down Arrow or Enter buttons will also do this.



Previous Field

The Previous Field button will advanced the cursor to the Previous Field.

The Up Arrow will also do this.



Edit Quantity

The Edit Quantity check box allows the user to be prompted to enter a Item quantity, if disabled then the user is not
prompted and a default value of 1 is used.



Quit Data Entry

The Quit Data Entry button will exit the editing mode which was selected using the Add Data or Change Data
commands.

The Esc (Escape) will also do this.



Style Menu

This menu can be used to change the themes that the program can be displayed in.



Information Menu

This menu contains the following sub items.

Help
Show Mouse Operation Help

Technical Support
About



This will display the Help file. To go directly to a topic based on the programs current screen press F1.



Show Mouse Operation Help

This item will display the Mouse Operation topic of the Help file.



echnical Support

This menu item will display the Technical Support topic of the Help file.



This screen shows information about the program.



Quick Access Toolbar

This option ( Small arrow ) is used to create shortcuts to main commands so they are directly visible on the main
screen at all times.
By default no shortcuts are created.

Clicking the arrow will display a menu with the following options:

Customize Quick Access Toolbar - this allows the File Button
selected.

Product Tab, Data Entry Tab and Print Tab options to be

Quick Access Toolbar Below Ribbon or Quick Access Toolbar Above Ribbon - this will move the position of the
toolbar.

Minimize Ribbon - this will minimize the ribbon so the command are only visible when the ribbon is selected.



Customize Quick Access Toolbar

This screen allows users to select which commands or menus are available on the Quick Access Toolbar.

Note

These settings are per user based so if multiple users logon to the Windows PC then they will have to configure these
settings individually.



Ensure the latest version is installed if having issues with the program.

HEW

New Feature

Improvement

Resolved Issue

== v7.1.00 - Released 24th November 2021

* Auto Size Length
The logic for allowing Auto Size Length continuous products was fixed in v7.0.06 for the T6112DS
printer but the fix made all the other printers not allow this option.

= v7.0.06 - Released 2nd November 2021

Note

Version 7.0.06 has new print features that are now saved in the Data Files (*.wdfx) that were previously
stored in the programs settings file.

Older versions can still open and use files with these new settings but they will be ignored.

If you have multiple WinTotal installations it is recommended to update all to this version to prevent
printing differences.

* Windows 11 Support
This version is now supporting Windows 11. Older versions may work but cannot be officially
supported as they were made before Windows 11 was released.

* Print Screen Redesign
The Print Screen has been redesigned with the following changes.

1. Graphical buttons with mouseover tooltips replace check boxes for options that can be turned on
and off. F1 help on this screen will also show the button images next to the texts.

2. The options below are now saved in the current data file for the selected Product and Printer
combination. This enables the product to be printed with the last values for this combination not
the last global values.

» Leading Zeros

= Mirror Print

= Reverse Line Order
= Reverse Print Order
= Rotate 180°

= Print Cut Line

= Print Back Side

= Print Both Sides

3. Input boxes have Improved validation rules. If possible errors will be automatically corrected, if
they can't an error message will be displayed indicating the problem. Printing cannot continue
until all errors are cleared. The previous version would disable the Print button with no
explanation what the error was.

4. To and From items can now only be selected when using the Range option.



5. To and From item values now can only be entered and displayed in positive increment values. Eg
From 1 To 10. Itis no longer allowed From 10 To 1

6. The Print Order is now shown in text under the Template name in the print screen. This shows
the order that the data is printed based on Printer, Back Side and Reverse Print order options.

7. Printer Ports now only show valid ports with a printer driver connected to them. It is no longer
possible to manually type in ports.

8. The Perforate option now had an additional Time option where additional time can be specified
to the Perforator. The higher the number the deeper the perforation will be.

® Advanced Printer Setup Redesign

The following changes have been made to the Advanced Printer Setup section of the Printers tab in
the System Setup

1. New buttons and method for Adding, Changing and Deleting Printer Parameters.

2. Printer Parameters screen has been replaced with a new screen using the same options in the
Print Screen Redesign.

3. Printer Parameters screen now supports all Print Cut Line, Back Side, Reverse and Both Side
options.

4. Printer Parameters screen Collate option is no longer available. This can be set in the Print
screen manually as it is not supported in Advanced Print

5. When using the Windows Printer the port option is now hidden as it has no use. The user either
prints to the Windows Default Printer or is shown a screen to select the printer.

* Delete Product
The Delete Product option has been redesigned with the following changes

1. When selected the current product is no longer deleted but a new dialog shows all the products
in a file that can be deleted. It will select the current product as default but more products can
be selected if required.

2. This dialog is now sizeable to allow more information to be visible.

® Advanced Print
The following changes have been made to the Advanced Print screen.

1. This dialog is now sizeable to allow more information to be visible, this sizes state is saved for
future use.
2. The Reverse Print Order, Back Side Print and Mirror Print options now support a 3 way checkbox.
» Ticked and Unticked status's work as previous to set values on or off for all selected items to
print.
= The new Squared status will not set these values for all items but use any Printer Parameters
enabled for each product or the last printed value for the printer currently assigned.

+ Template Changes
The following templates are now available in the color Black

HT-CT
HX-CT
RPS-CT
TMS-CT

+ Installation Changes

The installation no longer installs the windows printer drivers if they are not detected. If you require
them please contact your TE Technical Support contact.

+ Repeats
Repeats will now display WYSIWYG. Previous versions only shows the source data but printed the
repeats. Now the program will display the repeated data as it is entered.



% Advanced Print
The following issues have been fixed in the Advanced Print screen.

1. When printing files for the T6112DS using Advanced Print the back side data was not printed.

2. The Printed First screen was shown when printing from Advanced Print when it should never be
shown

3. The Stop After Printing First screen would be shown sometimes when it should not be used in this
printing mode.

4. The first item was not printed if the Stop After Printing First option was on.

5. The Print button was not disabled after printing when the queue was empty.

% XMT Server
When printing with the Stop After Printing First option ON and the Disable Print Screen Prompt
option enabled the first item was not printed.

% Cutting
Cutting non continuous labels did not save the cutting options so when the product was reloaded
the cutting was off.

% System Setup
Changes made to the check boxes on the Printers tab in the System Setup screen were not saved if
the OK button was pressed whilst in one of the other tabs

% Autosize Font
The Autosize Font option did not work due to the Line Spacing fix made in v7.0.05.

% Print Screen
The following issues have been fixed relating to the Print Screen

1. When printing continuous products the print screen always showed the length of the product in
mm even if inches was selected in the System Setup

2. When printing Selected items the Error 50007 code would be shown and the print output would
fail.

3. When printing to the T6112DS printer a product that was created for a Single Sided printer the
print options for Double Sided were not shown correctly as for the T6112DS printer. The print
preview still does not show correctly but in these cases the user should change the product so it
enables the Double Sided option.

% Font Height
Field height were not calculated exact in some scenarios in the Label Editor.
On some product / font combinations there could be a +1 dot change in the fields when printing.

% MY Designs - Import
If previously created designs have been deleted when importing new ones it could overwrite an
existing one.

" Serializations
The following issues regarding serializations have been resolved

1. Closing the Serialization dialog using the ESCAPE key would cause the program to crash
2. If a item with serializations had them all then removed the character positions where it have
counter would still count.

% T6112DS Auto Size Length
The logic for allowing Auto Size Length continuous products was inverted for the T6112DS printer. It
should only be allowed if Double Print Optimize is on. This was incorrect from v7.0.00 to v7.0.05



v7.0.05 - Released 10th May 2020

“ XMT Import Server
¢ New Import and Import and Print options.
XMT Import Server is now always minimized when started. If maximized the minimize button now
minimizes the icon to the system tray.
New Stop and Start buttons added to the ribbon.
When running all other options are now disabled.
WinTotal crashed if Exit was selected from the System Tray

For a more detailed view of the changes please read the XMT Import Server topic.

+ Add Product
The Add Product screen now allows Products that already exist in a file to added multiple times. In
previous versions this was not allowed
The user will be prompted if an exact product match already exists in the file with the option to
continue or stop.

* Database Connection Name
Using a very long name in the Database Connections screen may cause the connection to not be
saved. The limit of 100 characters for connection name is now in place

* Program Crash
Improvements to the opening and closing of the program to prevent crashes if the program is
restarted too quickly whilst the old instance is still closing.

% Selecting Items
After printing it was sometimes not possible to use the program for any other function unless the
program was restarted.

% Duplicated Products
The following Products were in the Template list twice. Files using these will be converted
automatically.

HPR100A 0350091
HPR100A 500172.5

% Print Preview
The Print Preview did not work when using the Print Back Side option.
Now when printing Double Sided Products only the side or sides to be printed will be shown.

% Print Front As Back
The Print Front Side As Back option in the Printers tab in the System Setup screen did not function
correctly for all printers.

% MY Designs
With a MY Layout or My Product assigned to a Printer in the Printers tab in the System Setup
screen, if the Change button in the Assign Templates section was clicked it did not select the
original item but the first one in the list.

MY Layouts
With a MY Layout assigned to a Printer in the Printers tab in the System Setup screen and
then the assignment is removed the program would crash.
Upon restart the System Setup could not be entered without the program crashing unless the
MY Layout was added back.




MY Products
e Creating a My Product using a Template that was assigned to printer not the Default
Printer the assigned printer was not set. Instead it took the first allowed Printer in the
Printers tab in the System Setup screen.
¢ Using the Advanced Formatting option for a My Product using the T6112DS Printer if a
field on the Front Side was edited on OK it would move to the Back Side.

% Line Spacing
Line Spacing values in the Print screen did not save to the file. Once a new Product was selected
upon reloading the original file it would revert back to default.

% System Setup
The Import option in the Printers tab in the System Setup screen did not import the following
options for the Default Printer.

Print Front Side As Back

Cutter

Copy Front Side Data To Back Side
Use Default Windows Printer
Double Print Optimize

% XMT Import
Importing a XMT file with a Product with an invalid color should not be allowed. Prior to this
version it was imported and displayed in the Selected Product list.
However when selected the user was prompted to change the product. Now an error will display
and the rest of the XMT file is ignored.

% Data Entry
When changing to or from a T6112DS printer to another, if selecting an existing Product with no
data and using Add Product it would edit the second item not the first.

v7.0.04 - Released 17th January 2020

* New Printer
The 6" wide Squix 6.3/300 printer has been added with support for TTVF labels.

+ Template Changes
TTVF labels now support the Clear color.

The following label templates have been added.

TTVF 1029-5
TTVF050020-10

" S 'Log Printed Products

The Log Printed Products option implemented in v7.0.02 did not create the Print Log directory if
the user upgraded from a previous version.

This then displayed an error when printing that the logging could not be done. The folder is now
created and the program only checks the validity of the Print Log directory if using the Log Printed
Products in the Options tab in the System Setup screen.

= v7.0.03 - Released 8th January 2020



¥

“L'Log Printed Products
The Log Printed Products option has been enhanced to contain the additional information for
Printer and Port.

% MY Products
The following changes were made related to MY Products.

MY Product - Formatted
1. Any My Product - Formatted could be created with the wrong default margins if the
Advanced Formatting option was selected when creating the product for the first time.
2. Left Margin and Top Margin values at Print time did not move the printed data. The
values applied were taken from the default margin set at creation time not the values in
the Print screen.

= v7.0.02 - Released 9th December 2019

ol :Log Printed Products
The Log Printed Products option has been enhanced for advanced logging. Please read the
documentation in the Options tab in the System Setup screen for more information

" F." Advanced Print

If the same item was added to the print queue the program could sometimes crash

' My Layout - Vertical Pitch
The following printers did not print correctly a MY Layout with a Vertical Pitch value less
than the Height plus 0.5mm
Cab A4+300
T200 Ident
T2000CT
T2212
T3212
T3224
T6112DS
TE3112
TE3124

v7.0.01 - Released 25th November 2019

&

" "' License Agreement
An updated License Agreement is in the installation and the help file.

% MY Designs
The following changes were made related to the MY Designs. option
The following changes were made in the MY Layouts

Naming
If a MY Layout was created with the exact name as a TE Layout the following issues
occurred.

1. With the MY Layout opened if the Change Product option was used it would
select the TE Layout not the MY Layout in the Change Product screen.

2. It was also not possible to add both the MY Layout and TE Layout in the same
file.



Continuous Layouts
If a MY Layout was using the Continuous option the following issues occurred.

1. The MY Layout would be displayed rotated 90°.
2. The MY Layout would not be useable in any part of the program until the program
was restarted and the template was reloaded from the MY.tfs file.

Missing Layouts
If a MY Layout was opened in a file but was missing from the MY Designs screen the
user is prompted and the option to change the product is available.
If changed the new product selected is created but the data from the MY Layout was
not. Both the missing MY Layout and newly changed product would then both exist in
the file.

Vertical Pitch
The following printers did not print correctly a MY Layout with a Vertical Pitch
specified.
Cab A4+300
T200 Ident
T2000CT
T2212
T3212
T3224
T6112DS
TE3112
TE3124

Color
If a MY Layout was create for one color and used in a file.
Then the MY Layout color was hanged to another one when the Product was opened
the wrong error message would be displayed.
Changing the product would cause the program to crash and it would not allow the
Product to be opened or changed without reverting the MY Layout to the previous
color.

MY Products
The following changes were made related to MY Products.

MY Product - Formatted
Any My Product - Formatted created using the MY Designs or Convert v6 Data
option that contained fixed data fields using non ANSI characters would show this data
incorrectly. The data was not saved correctly in a Unicode format.

" " File Management

The following changes were made related to file management.

“L'start With Last File
When using this option the program when restarted will open the last used. But then when
browsing for a new file to open the default browsing location was reset to the default Data
Directoryconfigured in the Directories tab of the System Setup screen
This will now open the folder where the last used file is located so it behaves the same as the
Open option.

Filename using multiple dots (.)
When using files with multiple dots (.) in their filename the following issues occurred.

1. The Import and Open option in the Import screens would not open the file and product.



2. Opening files of folders throughout the program could change the current working
Directory so when the user selected the Open open option they would be in the wrong
folder.

"' XMT Server
If the XMT server crashed or was terminated upon restart it could begin printing all the
previously import XMT products again as the old file used was not removed.
All old XMT server temporary files are now removed on restart.

i Convert v6 Data
The Data Files - Single Selection option in the Convert v6 Data module allows for multi file
selection. If more than 1 file was selected it would always show an error message and not
convert them.

™ 5 Importing
When using the Import Ascii Text or Import Database options and creating a new or opening an
existing file the Product selection grid of available products was not used to lookup if the product
existed.
The internal lookup got this value from the grid values when the import screen was opened and was
not updated with the new files products. This resulted in not being able to add products or allowing
the same product to be added multiple times.

" 5.7 Windows Printer
If printing sheet based products with a quantity less than a full page the print prompt did not display
in the foreground

%

L' No Valid Printer
The error message showing that no valid printer for the current product was available was truncated
so some of the error message was missing.

" Zoom Ratio - Multi Column Labels
The zoom ration for multi column labels after printing was set different to that when created. Now
the zoom ration for this is the same as if it was a single column label

v7.0.00 - Released 11th September 2019

* v7.0.000.000 Released
For a summary of changes made in v7 please read the New Features and Changes in v7 topic .



echnical Support

If experiencing technical difficulties using the program, the first thing to do is to refer to this on-line help.

If the supplied documentation does not solve the problem please contact the vendor where your purchased the
program from or Technical Support

Global Email Support
ident.tech.support@te.com

Web Site Links
http://www.te.com/usa-en/products/identification-labeling.html

Telephone Support

Australia
Toll Free 1-800-144-078

New Zealand

Toll Free 0800-TYCO-HELP
Ireland
Toll Free 800 557 810

United Kingdom
Toll Free 0800988 9177

United States of America
Toll Free 1-800-430-7226


mailto:ident.tech.support@te.com
http://www.te.com/usa-en/products/identification-labeling.html
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